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	 Introduction

Welcome to ColorPlay 3
ColorPlay 3 is the light show authoring software component of the iPlayer 3 and 
iColor Player controllers from Color Kinetics. ColorPlay 3 gives you the tools you 
need to create and manage dynamic, color-changing light shows, including fully 
customizable effects, multi-track editing, effect stacking, and custom transition 
styles. ColorPlay 3 works seamlessly with iColor Player and iPlayer 3 to transform 
spaces, help you achieve your design goals, and add new levels of sophistication to 
LED lighting installations.

With ColorPlay 3, you can:

•	 Create dynamic light shows and original lighting effects without a lighting 
board, programming language expertise, or specialized knowledge of the DMX 
protocol

•	 Perform visual effect editing either on screen or live on a network of fixtures

•	 Simulate, preview, and scrub light show output

•	 Download light shows, triggers, and alarms to a controller and manage your 
show files

•	 Include multiple shows within each ColorPlay 3 project
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About This Guide
This user guide contains step-by-step installation instructions on all ColorPlay 
3 features and commands. Because ColorPlay 3 is a cross-platform software 
application, all functions are identical on compatible Mac OS X and Windows 
computer systems.

Technical Support Contacts
Contact Color Kinetics technical support for assistance with ColorPlay 3 software:

Phone
888.385.5742, press option number 3 (toll-free US, Canada and Mexico)

617.423.9999, press option number 3 (toll worldwide)

Email
technicalsupport@colorkinetics.com

Web
www.colorkinetics.com/support/
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1	 Installing ColorPlay 3

You can install ColorPlay 3 software on compatible Windows and Mac OS 
X computers. Before installing, close all running applications, disable virus 
protection, and ensure your computer meets the following system requirements:

System Requirements
Windows MacOS X

Windows 7 or newer MacOS X 10.9 or newer

512 MB RAM 512 MB RAM

30 MB free disk space 30 MB free disk space

You can download ColorPlay 3 from the Color Kinetics website at www.
colorkinetics.com/support/colorplay3/.

Install ColorPlay 3
ColorPlay 3 is easy to download and install. Download the installation package for 
your operating system from www.colorkinetics.com/support/colorplay3/, and then 
extract the installation files to a location on your local computer.

•	 If using Windows, double-click ColorPlay3Installer.exe to begin installation, and 
then follow the on-screen instructions.

•	 If using Mac OS X, launch the ColorPlay3Installer app. If you are unable to 
launch the app, update your Security & Privacy Settings in System Preferences.
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2	 Getting Started
This chapter describes:

•	 How to connect to the DMX lighting network

•	 How to start ColorPlay 3

•	 The components of a ColorPlay 3 light show

•	 The basic light show authoring workflow from concept to implementation

•	 The major features of the ColorPlay 3 environment

Starting ColorPlay 3
•	 To start ColorPlay 3 in Windows, click the Start button, navigate to All 

Programs>Color Kinetics>ColorPlay 3, and click ColorPlay 3.

•	 To Start ColorPlay 3 in Mac OS X, go to the Applications>ColorPlay 3 folder, and 
double-click ColorPlay 3.

The ColorPlay 3 window is displayed.
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What’s in a ColorPlay 3 Light Show
A light show is a set of digital instructions defining how and when a system of 
LED lighting fixtures produces illumination. Whether your light show is a simple 
color fade on a single fixture, or a complex presentation encompassing dozens of 
fixtures each displaying unique effects or layers of effects, the goals are the same: 
to create mood, interest, and impact.

A ColorPlay 3 light show contains four main elements:

•	 Fixtures correspond to the layout of your lighting installation—both the number 
and type of LED light sources (nodes) within each lighting fixture, and the 
positioning of the lighting fixtures in one or more rooms or spaces

•	 Groups synchronize fixtures for sequencing and effects

•	 Effects are dynamic patterns of light applied to groups. ColorPlay 3 offers 
over 20 effects, from Fixed Color to Video. Each effect has a full set of 
customizable properties.

•	 Configurations contain playback instructions, including triggers and optional 
alarms

Light Show Authoring Workflow
Authoring a ColorPlay 3 light show generally involves five steps. Light show 
authoring is an iterative process. You may find yourself revisiting any or all of 
these steps as you create, test, and refine your light show.

These steps, and the ColorPlay 3 features that support them, are discussed in 
detail in the chapters that follow this one.

Step 1: Map Fixtures
Each ColorPlay 3 show begins as a virtual map of light fixtures. A map is a virtual 
representation of your lighting installation, including light node addressing and 
relative light fixture positioning. The new Patch layer makes it easy to match your 
light map’s addressing scheme with the addresses assigned to the light nodes in 
your lighting installation.

> See Chapter 3: Light Maps

Step 2: Group Fixtures
Once you’ve mapped your fixtures, you arrange them into groups. Groups 
coordinate the show, enabling you to assign effects across multiple fixtures 
simultaneously and rapidly change sequencing to match your installation. To 
display an effect, a fixture must belong to at least one group.

> See Chapter 4: Groups

Step 2: Create Effects
After creating groups, you can begin assigning effects to them. Each effect has 
editable properties—color palettes, start time, duration, and so on. Effects are 
applied to groups, not fixtures; to assign an effect to a fixture, that fixture must be 
part of a group. You can assign multiple effects to a single group, either stacked to 
play simultaneously, or consecutively along the timeline.

> See Chapter 5: Effects
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Step 4: Simulate and Refine Your Light Show
You simulate and refine a light show with the Timeline Editor. The Timeline Editor 
contains multiple tracks, or rows, which let you quickly adjust effect properties, 
modify effect transitions, and manage multiple effects. The Timeline Editor 
contains playback controls for previewing your show on-screen or running your 
show live on installation fixtures.

> See Chapter 6: Timeline Editor

Step 5: Download and Configure Your Light Show
The final step in creating a ColorPlay 3 light show has two stages. First, you 
download your show files to an iPlayer 3 controller or the SD card on a ColorBlaze 
TRX fixture. Then you configure show playback by creating triggers and 
optional alarms.

> See Chapter 7: Configuring Shows

Exploring ColorPlay 3
The main areas of ColorPlay 3 are the mapping area, which includes the Fixtures, 
Patch, Groups, Effects, Background, and Configuration Layers, and the Timeline 
Editor, which includes simulation and playback controls for testing and fine-tuning 
light shows.

Menus
Toolbar

Properties panel

Mapping area

Timeline

Mapping Area
In the mapping area, you create virtual fixtures that correspond to the layout 
of your lighting fixtures in the real world. The mapping area also lets you group 
fixtures, assign effects, and view on-screen simulations of your shows.

The mapping area consists of six layers—Fixtures, Patch, Groups, Effects, 
Background, and Configuration—accessible via tabs along the top.
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Fixtures Layer
The Fixtures Layer appears by default when you launch ColorPlay 3. In the Fixtures 
Layer, you can map your installation by plotting fixtures on the mapping area. Use 
the scrollbars to view the entire workspace.

Fixture Properties Panel Fixture Palette

The icons on the Fixture Palette represent many of the most commonly used 
LED lighting fixtures from Color Kinetics. You drag these icons onto the mapping 
area to build a virtual map of your lighting installation. You can use the Fixture 
Properties Panel to rename, reposition, and readdress fixtures on the map.

> See Chapter 3: Light Maps
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Patch Layer
The Patch Layer displays a grid of addresses for the two DMX universes that iPlayer 
3 can control, and a third DMX universe for unassociated fixtures. The Fixtures Layer 
and Patch Layer work together: When you add and address a fixture in the Fixtures 
Layer, it appears in the correct location in the Patch Layer. Similarly, when you add and 
address a fixture in the Patch Layer, the Fixtures Layer automatically updates to reflect 
your changes.

You can drag fixtures onto the Patch Layer. If a fixture has multiple nodes, you can 
manipulate individual nodes or the fixture as a whole.

> See Chapter 3: Light Maps
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Groups Layer
Click the Groups tab to display the Groups Layer. You coordinate the show by 
assigning one or more fixtures, or nodes in one or more fixtures, to each group. 
Effects are applied to groups, rather than to fixtures. If you want to assign an 
effect to a single fixture, that fixture must be assigned to its own group. If you 
assign multiple fixtures to a group, you can select from a variety of preset node 
patterns to set the starting node, direction, or sequence for certain effects.

You can reposition the groups on the Groups Layer by selecting and dragging, 
resize them using the resize handles, and modify group properties using the 
Group Properties panel.

> See Chapter 4: Groups
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Effects Layer
Click the Effects tab to display the Effects Layer. With the Effects Layer, you can 
assign one or more effects to each group by dragging an effect from the Effects 
Palette to a group.

In-context tools such as the Color Palette, Effect Properties Panel, Properties Disc, 
and Timeline Editor give you fine control over effect properties and playback. You 
can choose from 24 effects, including Chasing Node, Sweep Node, and Video 
effects, and five modifier effects.

Fixed Color

Cross Fade

Color Wash

Chasing

Chasing Node

Sweep

Sweep Node

Sparkle

Streak

Spiral

Burst

Random Color

Image Fade

Video

Text

Strobe

Ripple

Particle

Colored Bars

Constant Modifier

Wave Modifier

Fade In/Fade Out 
Modifier

RGB Range Modifier

Perlin Noise Modifier

> See Chapter 5: Effects
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Background Layer
Click the Background tab to display the Background Layer. The Background 
Layer lets you import and annotate a static image to serve as a template for 
placing fixtures on the mapping grid. For example, you can use a blueprint, 
floor plan, or other image to represent the relative positions of lighting fixtures 
in an installation, then label the image to identify locations, fixtures, and key 
architectural features.

> See Chapter 3: Light Maps
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Configuration Layer
Click the Configuration tab to display the Configuration panel. The Configuration 
panel lets you configure shows for playback with triggers and alarms, copy shows 
to a controller or ColorBlaze TRX fixture, and manage show files.

> See Chapter 7: Configuring Shows
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Toolbar
The Toolbar provides tools relevant to the currently selected mapping area layer. 

Pointer The Pointer is the default tool in ColorPlay 3. When the Pointer 
is active, ColorPlay 3 is in selection mode. Use the Pointer to make menu 
selections, select and move objects, click icon buttons, and so on.

Zoom In With the Zoom In tool selected, click the mapping grid to zoom in. 

Zoom Out With the Zoom Out tool selected, click the mapping area to 
zoom out.

Zoom To Fit Click the Zoom To Fit tool to automatically resize the mapping 
area, displaying all fixtures and groups.

Drag Layer Using the Drag Layer tool, you can click and drag the mapping 
area to reposition it within the open ColorPlay 3 window.

Change Node Order The Change Node Order tool is available on the 
Groups Layer and Fixtures Layer. On the Groups Layer, use the Change 
Node Order tool to manually designate a node order. On the Fixtures Layer, 
use the Change Node Order tool to change the starting DMX addresses 
of nodes.

Exclude Nodes From Group The Exclude Nodes From Group tool is 
available in the Groups Layer. With the Exclude Nodes From Group tool 
active, click one or more nodes in the selected group to exclude them from 
the group.

Clone Fixtures The Clone Fixtures tool is available in the Fixtures Layer. 
With the Clone Fixtures tool active, click a fixture and then drag to create 
multiple instances of that fixture.

Show Fixture Profiles The Show Fixture Profiles tool is available on the 
Fixtures Layer, where it turns visual display of fixture profiles (fixture 
resolution, color control mode) on and off.

Timeline Editor
The timeline editor lets you sequence, set the duration of, and fine-tune effects. 
Simulation playback controls let you preview shows, either on your computer or 
on your installed lights.

> See Chapter 6: Timeline Editor
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3	 Light Maps

Before creating groups and assigning effects to them, you must create a light map 
in ColorPlay 3. A light map is a virtual representation of your lighting installation. 
To correctly direct the output of your light shows, you assign fixture addresses 
to your light map that match the addressing scheme of the fixtures in your 
installation. You create a light map using the Fixtures Layer, the Patch Layer, or 
a combination.

You can address and install your fixtures first, then use the addresses you 
assigned to create your light map in ColorPlay 3. Alternatively, you can create a 
light map in ColorPlay 3 first, then use the light map’s addressing scheme as the 
lighting design plan for addressing your fixtures. It doesn’t matter which approach 
you use, so long as the addresses in your light map match the fixture addresses in 
your lighting installation.

Keep in mind that your fixtures must be installed and properly addressed in order 
to use the Live Play show preview and simulation features in ColorPlay 3. See 
Chapter 6 for complete details on using Live Play.

Addressing
In order to properly address your fixtures and configure your light map, it’s 
important to understand a few addressing-related concepts and terms.
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DMX Addressing
iPlayer 3 supports two DMX universes. Since a DMX universe consists of 512 DMX 
addresses, iPlayer 3 can control up to 1,024 DMX addresses simultaneously.

The number of addresses an LED lighting fixture requires depends on a number of 
factors, including number of LED channels, fixture node count, and fixture resolution:

•	 To display color-changing light output, a lighting fixture must have at least three 
separate LED channels—one channel of red LEDs, one channel of blue, and one 
channel of green. LED lighting fixtures with expanded color range can have more 
than three LED channels. ColorBlast TRX, for example, normally has five LED 
channels—one channel each of red, green, blue, amber, and white LEDs (RGBAW).

•	 Some Color Kinetics lighting fixtures have multiple nodes—multiple individually 
controllable full-color segments. ColorBlaze 72, for instance, has up to 12 
individually controllable nodes, while iColor Tile MX has 144 individually 
controllable nodes. Many lighting fixtures have only one node. Single-node 
fixtures include ColorBlast Powercore, ColorBurst Powercore, C-Splash 2, and 
iColor MR g2.

•	 At 8-bit resolution, a fixture requires one DMX address per LED channel per node. 
At 16-bit resolution, a fixture requires two DMX addresses per LED channel per 
node. For example, ColorBurst Powercore gen2 RGB (8-bit resolution, one node) 
uses 3 DMX addresses. iColor Flex LMX gen2 (RGB, 8-bit resolution, 50 nodes) uses 
150 DMX addresses. ColorBlast TRX uses 3, 5, 6, or 10 DMX addresses depending 
on configuration (RGB or RGBAW, 8-bit or 16-bit, one node).

When you address a fixture, you set its starting DMX address. Sequential DMX 
addresses are automatically assigned to the fixture beginning with the starting 
DMX address. You can quickly view the starting DMX address and total number of 
addresses assigned to a fixture on the Patch Layer. The light map shown below, for 
instance, shows the following:

•	 Two ColorBurst Powercore gen2 fixtures, each using eight DMX addresses (RGBA, 
16-bit, single node), with starting addresses of 1 and 9, respectively

•	 Six ColorBlast Powercore gen4 fixtures, each using three DMX addresses each 
(RGB, 8-bit, single node)

•	 One PureStyle Intelligent Color Powercore, RGBA fixture, using 16 consecutive 
addresses (RGB, 8-bit, four nodes).
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In 16-bit mode, DMX addresses are assigned to LED channels in pairs. Let’s use the 
ColorBurst Powercore gen2 fixture as an example, shown in the previous image. 
The fixture has a starting DMX address of 1 and contains four LED channels (red, 
green, blue, and amber. In 16-bit mode, the fixture is addressed as follows:

1 2 3 4 5 6 7 8

Red 
Coarse

Red  
Fine

Green 
Coarse

Green 
Fine

Blue 
Coarse

Blue  
Fine

Amber 
Coarse

Amber 
Fine

Fixture Addressing
As described in the Addressing and Configuration Guide, you address and configure 
your lighting fixtures using either QuickPlay Pro addressing and configuration 
software or a fixture’s or power/data supply’s on-board controls. Although 
addressing and configuration methods can differ depending on fixture type, the 
end result is always the same: assigning consecutive DMX addresses to each 
fixture node. For your light shows to function properly, the DMX addressing 
in your ColorPlay 3 light map must match the DMX addressing in your real-
world installation.

Nodes which are intended to display the same light output simultaneously can 
all use the same DMX addresses. Certain effects, such as Fixed Color, Cross Fade, 
Color Wash, and Random Color, always show the same light output on all nodes 
simultaneously. For all other effects, which show different light output on different 
nodes simultaneously, you must assign unique DMX addresses to each node. For 
complex installations with many nodes, careful planning may be necessary to 
avoid exceeding the iPlayer 3 limit of 1,024 unique DMX addresses.

A Note About Light Numbers
In QuickPlay Pro, you can address fixture nodes using either DMX starting 
addresses or light numbers. Light numbers are a shorthand for identifying the 
DMX channels assigned to a node. They work best in installations that include 
three-channel nodes only. For installations including fixtures with nodes of more 
than three channels, such as ColorReach Powercore gen2 and ColorBlast TRX, we 
recommend using DMX addressing in QuickPlay Pro to avoid confusion.

Fixtures Layer vs. Patch Layer: Which 
to Use?
You can create a light map using either the Fixtures Layer or the Patch Layer. 
Because each layer offers different capabilities and a different view of the map, 
you’ll probably use both layers. The Fixtures Layers gives you a spatial view 
of your light map: that is, you can arrange your fixtures spatially to mimic or 
approximate your lighting installation. The Patch Layer, on the other hand, gives 
you an addressing view of your light map: fixtures appear in order by starting DMX 
address, regardless of their positioning relative to one another in space.

If you make changes to fixture addressing, DMX universe assignment, node type, 
dimming curve, or name on the Fixtures Layer, those changes are automatically 
reflected on the Patch Layer, and vice versa. Some features of the Fixtures Layer—
fixture icons, their x and y coordinates, and their height and width—are not 
relevant to the Patch Layer and are therefore not shown. Similarly, the Zoom To Fit, 
Change Node Order, and Clone Fixtures tools are unavailable on the Patch Layer.
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Creating a Light Map with the Fixtures Layer
With the Fixtures Layer, you can arrange fixture icons on the mapping area to 
approximate the placement of fixtures in your lighting installation. For help in 
creating your virtual layout, you can import a static image, such as a blueprint or 
graphic via the Background Layer, and annotate it. This annotated image appears 
as a guide underneath the mapping grid on the Fixtures Layer.

Adding Fixtures to the Fixtures Layer
To save you time and help distinguish between different types of fixtures in an 
installation, the Fixture Palette offers pre-configured icons for many of the most 
commonly used Color Kinetics LED lighting fixtures.

To add fixtures to the Fixtures layer:

1.	 Click the Fixtures tab to open the Fixtures Layer, or choose Layer>Fixtures.

2.	 Drag a fixture icon from the Fixture Palette to the mapping area. ColorPlay 3 
automatically assigns the appropriate number of DMX addresses in sequence, 
beginning with the starting DMX address

•	 Single-node fixtures use a single set of consecutive DMX addresses. Use 
the generic Rectangular Fixture icon to represent fixtures that have no 
Fixture Palette icons, or to represent individual nodes in any multiple-
node fixture.

•	 Multiple-node fixtures have two or more nodes. ColorPlay 3 automatically 
assigns a sequence of starting DMX addresses to each fixture node. When 
you change the fixture’s starting DMX address, ColorPlay 3 automatically 
updates the addresses for all subsequent nodes in the fixture.

ColorPlay 3 automatically increments the starting DMX for each node 
according to the fixture’s node type. For example. each of the three 
ColorBlaze TRX fixtures shown below has a different node type. The first 
fixture has six 8-bit RGB nodes, each of which takes three DMX addresses. 
With a starting DMX address of 13, ColorPlay 3 automatically assigns 
starting DMX addresses to each subsequent node, in increments of three. 
The second fixture has six 8-bit RGBAW nodes, each of which takes five 
DMX addresses, so the starting DMX address of each subsequent node is 
incremented by five. The third fixture has six 16-bit RGBAW nodes, each 
of which takes 10 DMX addresses, so the starting DMX address of each 
subsequent node is incremented by 10.

For some fixtures, such as iColor Module and iColor Tile, ColorPlay 3 
displays the starting DMX address of the first node only. (iColor Tile has 
two node sequences, so it displays the starting and ending DMX addresses 
for each sequence as a convenience.)

Module 6:9/Module 6:36

Tile

Single-Node Fixtures

ColorBlast 6

ColorBlast 12/Blast Powercore gen4

iColor Cove 6 in/12 in

Circular Fixture

ColorBurst

Rectangular Fixture

ColorReach Powercore 3-channel

Multiple-Node Fixtures

ColorBlaze 48

ColorBlaze 72

ColorGraze Powercore 2 ft

iColor Accent Powercore 2ft

ColorGraze Powercore 4 ft

ColorReach Powercore 6-channel

ColorBlast TRX

ColorBlaze TRX 6 ft

ColorBlaze TRX 2 ft
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ColorGraze Powercore is a special case. Each ColorGraze Powercore node 
has its own serial number and starting DMX node property. This means 
that you must set each starting DMX address individually; ColorPlay 
3 does not automatically increment the starting DMX addresses of 
subsequent nodes.

Other fixtures, such as iColor Accent Powercore and the four ColorBlaze 
fixtures, have variable node counts. Icons for these fixtures use the 
maximum node counts. If you’re using these fixtures at lower node counts, 
use the correct number of Rectangular Fixture icons or other single-node 
fixture icons instead.

ColorBlaze TRX has an optional intensity channel, which you can enable 
to change the brightness of all LED channels simultaneously. When the 
intensity channel is enabled, each ColorBlaze TRX node consumes six 
DMX addresses in 8-bit mode, and 12 DMX addresses in 16-bit mode. To 
represent the intensity channel in a ColorPlay 3 light show, use the single-
channel fixture

3.	 Continue adding fixture icons until you have completed your light map:

•	 You can continue dragging icons from the Fixture Palette to the mapping 
area as described in step 2.

•	 You can duplicate fixtures by copying and pasting them. Right-click one 
or more selected fixtures and choose Copy from the pop-up menu, then 
right-click on the mapping area and choose Paste. Fixtures are assigned to 
the next available starting DMX addresses in order.

•	 You can use the Clone Fixtures tool to rapidly add multiple fixtures of the 
same type. Click the Clone Fixture tool, select the fixture you want to clone 
. . .

. . . drag the mouse until the preview shows the fixtures you want to create 

. . .

. . . . then release the mouse. ColorPlay 3 creates the icons, and assigns 
starting DMX addresses to them in sequence.

Single Channel icon
for ColorBlaze TRX 
intensity channel

Clone Fixtures tool

E You can also activate the 
Clone Fixtures tool by pressing C 
and dragging the mouse.
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Associating Fixtures with a DMX Universe
iPlayer 3 has two output ports, each of which controls a DMX universe of 512 
channels. By default, ColorPlay 3 associates nodes with one DMX universe until all 
512 channels are assigned, then associates nodes with the other DMX universe. 
Nodes added after all channels have been assigned are unassociated.

For easy recognition, nodes associated with DMX universe 1 are blue, nodes 
associated with DMX universe 2 are green, and unassociated nodes are gray.

Associated with DMX universe 1 Associated with DMX universe 2 Unassociated

To change the association of nodes:

1.	 Select one or more fixture icons, then choose Associate from the pop-
up menu.

2.	 Select Supply Port 1 or Supply Port 2.

3.	 Click OK.

To unassociate nodes:

Select one or more fixture icons, and choose Unassociate from the pop-up menu.

Changing Fixture Node Type and Displaying Fixture Profiles
Some fixtures, such as ColorBurst Powercore, ColorReach Powercore, and 
ColorBlast TR, can operate in both 8-bit and 16-bit mode. Fixtures such as 
ColorBlast TRX and ColorBlaze TRX can also accept both three-channel RGB input 
and five-channel RGBAW input. The node types assigned to fixtures in your light 
map must match the configuration of the fixtures in your lighting installation. You 
can display fixture profiles in the mapping area so that you can view the current 
node type assignments at a glance.

•	 To display fixture profiles in the mapping area, click the Show Fixture Profiles 
tool. Node type icons appear beneath each fixture on the light map.

	 For example, the four ColorBlast TRX fixture icons below show the four node 
types the fixture supports.

16-bit RGBAW 16-bit RGB 8-bit RGBAW 8-bit RGB

To change a fixture’s node type:

1.	 Select a fixture.

2.	 In the Properties panel, select a node type from the Node Type list. Make sure 
that the node type you select is supported by the fixture.

Show Fixture Profiles tool
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Changing DMX Starting Addresses
As you add fixtures to the mapping area, ColorPlay 3 automatically assigns the 
next available set of consecutive DMX addresses in sequence. If necessary, you 
can change the starting DMX addresses in your light map to match the DMX 
addresses of the fixtures in your lighting installation. You can change the starting 
DMX address(es) of a fixture’s node(s) with the Fixtures Property Panel or the 
Change Node Order tool.

Remember that the DMX addresses in your light map must match the addressing 
of your lighting installation. However, node addresses are not used to determine 
the node order for effects. Instead, node order for effects is determined by a 
group’s node pattern, the effect itself, or a combination of the two.

To change the starting DMX address for a fixture or node:

1.	 Do one of the following:

•	 Select a fixture on the light map, then enter the Node DMX property in the 
Fixtures Property Panel.

•	 Click the Change Node Order tool, then click the fixture the starting DMX 
address of which you want to change on the light map.

	 Single-node fixtures have one Node DMX property (Node 1 DMX).

	 Except for ColorGraze Powercore fixtures, multiple-node fixtures also have 
one Node DMX property (Node 1 DMX), which represents the starting address 
for the first node in the fixture. Starting DMX addresses are automatically 
assigned in sequence beginning with the address entered in Node 1 DMX.

	 ColorGraze Powercore (2 Foot) fixtures have two Node DMX properties 
(Node 1 DMX and Node 2 DMX), and ColorGraze Powercore (4 Foot) fixtures 
have four (Node 1 DMX through Node 4 DMX). Each of these properties is 
set individually.

2.	 Enter a new starting DMX address.

	 Although the range of DMX addresses in a universe is 1 – 512, the highest 
starting DMX address you can assign depends on how many addresses a 
fixture requires. For instance, the highest starting DMX address you can assign 
to a single-node 8-bit RGB fixture is 510, because the fixture requires three 
consecutive DMX addresses (510, 511, 512). The highest starting DMX address 
you can assign to an 18-node 16-bit RGBAW fixture is 333, because the fixture 
requires 180 consecutive DMX addresses (333 through 512).

3.	 If using the Change Node Order tool, press Tab and Shift-Tab to move forward 
and backward through the nodes the starting DMX addresses of which you 
can change. Enter new starting DMX addresses for each node that you want 
to change.

An orange warning icon appears on each node with conflicting DMX addresses. 
This is informational only, as some lighting schemes call for certain (or all) nodes 
to have the same addresses. Your light shows display properly as long as the 
addressing in your light map and your lighting installation match.

The Node 1 DMX property for a 
ColorBlast TRX fixture.

Change Node Order tool
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Changing a Fixture’s Dimming Curve
Many 8-bit LED lighting fixtures from Color Kinetics have a built-in dimming curve 
(Normal, or CK Gamma) that ensures smooth fading down to and up from black. For 
many fixtures with 16-bit operation, the dimming curve is always linear in 16-bit mode. 
Some fixtures, such as ColorBlast TRX and ColorBlaze TRX, offer the ability to set 
different dimming curves using on-board controls.

To support installations that contain a mixture of fixture types, ColorPlay 3 lets you 
explicitly assign dimming curves to individual fixtures:

•	 Linear  No dimming curve is applied to the ColorPlay 3 data (applied by default)

•	 Normal (CK Gamma)  The non-linear (gamma) dimming curve used in most Color 
Kinetics LED lighting fixtures.

•	 Tungsten/Incandescent  A non-linear dimming curve that emulates the dimming curve 
of incandescent lamps on a DMX dimmer. This curve offers the most control at 
low intensities.

If a fixture has no dimming curve of its own, assigning a dimming curve in ColorPlay 
3 applies dimming behavior to that fixture. If a fixture has its own dimming curve, the 
behavior of the ColorPlay 3 dimming curve is added to the behavior of the dimming 
curve on the fixture itself. To avoid unexpected results, make sure you understand how 
dimming curves interact in such situations.

For example, an installation contains both ColorGraze Powercore and iColor Flex LMX 
gen2 fixtures. ColorGraze is 16-bit-capable, and its dimming curve is always linear in 
16-bit mode. iColor Flex LMX gen2 is 8-bit only, and its dimming curve is always Normal. 
To ensure that the dimming curves of these two fixtures produce consistent behavior in 
your light show, set the dimming curve of each fixture in ColorPlay 3 to compensate for 
the differences between them. Assign the Linear dimming curve to the iColor Flex LMX 
gen2 fixtures, and the Normal curve to the ColorGraze fixtures. When you render your 
show, all fixtures should produce the same dimming behavior (normal and linear).

To set a fixture’s dimming curve:

1.	 Select a fixture.

2.	 In the Properties panel, select a dimming curve from the Fixture Curve list.

Renaming Fixtures
By default, fixture names are the fixture types (every ColorBlast 6 fixture is named 
ColorBlast 6, for example). You can rename fixtures in the Fixtures Property Panel 
to further distinguish them.

To rename a fixture:

Select a fixture in the mapping area, and then enter a new name in the 
Name property.

Arranging Fixtures on a Light Map
Once you’ve added fixtures to your light map, you can move them, align them, 
distribute them evenly over an area, or change their width, height, or orientation.

To arrange fixtures on the light map:

•	 To move fixtures, select one or more fixture icons in the mapping area and 
drag them.
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•	 To change the orientation of a group of fixtures, select two or more fixture 
icons in the mapping area, right-click, and select Flip Horizontally or 
Flip Vertically.

•	 To change the width and height of fixtures, select one or more fixture icons 
in the mapping area. Enter the desired Width and Height in the Fixtures 
Property Palette.

•	 To align a group of fixtures, select two or more fixture icons in the mapping 
area and right-click. Click Align, and then select an alignment option (Top, 
Bottom, Left, Right, Horizontal Center, or Vertical Center).

•	 To distribute a group of fixtures evenly across an area, select two or more 
fixture icons in the mapping area and right-click. Select Distribute>Horizontal 
Centers to spread fixtures evenly from top to bottom, or Distribute>Vertical 
Centers to spread fixtures evenly from left to right.

To delete fixtures:

Select one or more fixture icons in the mapping area, right-click, and select Delete.

Adding a Background Image to a Light Map
The Background Layer lets you import a static image for the background of a light 
map. You can use a blueprint or graphic as a reference for placing fixtures on the 
mapping grid, then annotate the image. For example, you can identify lighting 
fixtures, areas, and architectural elements.

To choose a background image:

1.	 Click the Background tab to display the Background Layer.

2.	 Right-click anywhere on the mapping area, and select Choose Image from the 
pop-up menu.

3.	 Navigate to an image file, and click Open.

To change the size of the background image:

In the Properties panel, adjust the size of the background image using the Height, 
Width, Vertical Scale, or Horizontal Scale controls.

To lock the aspect ratio of the image, set the Lock Aspect Ratio control to true. 
Otherwise, set it to false.

Before flipping horizontally

After flipping horizontally
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To annotate the background image:

1.	 Double-click the Text Box Annotation tool. A text box with placeholder text 
appears on the Background layer.

2.	 To edit the annotation text, double-click the text Value property in the 
Properties panel, and enter your text. You can change the typeface and type 
size with the Font and Text Size properties.

3.	 To resize the annotation, use the mouse to drag the edges or corners of the 
text box, or use the Width and Height properties.

4.	 To reposition the annotation, position the mouse pointer inside the text box 
and drag it to a new location, or use the X and Y properties.

To delete the background image:

Right-click anywhere on the Background Layer, and then select Clear Image.

Creating a Light Map with the Patch Layer
You use the Fixtures Layer, the Patch Layer, or a combination of the two to create a 
light map, which is a virtual representation of your lighting installation in ColorPlay 
3. To save time and help distinguish between different types of fixtures in an 
installation, the Fixture Palette offers pre-configured icons for many of the most 
commonly used Color Kinetics LED lighting fixtures.

Adding Fixtures to the Patch Layer
The Patch Layer contains two grids of 512 DMX addresses. One grid associates 
fixtures with DMX Universe 1 (Supply Port 1), the other with DMX Universe 2 
(Supply Port 2). A third grid lets you add fixtures without assigning them to a DMX 
universe (not associated).

To add fixtures to the Patch Layer:

1.	 Click the Patch tab to open the Patch Layer, or choose Layer>Patch.

2.	 Click the Supply Port 1 or Supply Port 2 tab along the top of the mapping 
area to choose the DMX universe to which you want to associate fixtures. 
To add fixtures without associating them to a DMX universe, click the Not 
Associated tab.

DMX universe tabs

Do one of the following:

•	 Drag a fixture icon from the Fixture Palette to the DMX address that you 
want to set as the fixture’s starting address. ColorPlay 3 automatically 
assigns the appropriate number of DMX addresses in sequence, starting 
with the starting DMX address.

Text Box Annotation tool
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•	 Double-click a fixture icon in the Fixture Palette to automatically assign the 
next available DMX starting address to the fixture.

	 Single-node fixtures use a single set of consecutive DMX addresses. Use the 
generic Rectangular Fixture icon to represent fixtures that have no Fixture 
Palette icons, or to represent individual nodes in any multiple-node fixture.

	 Multiple-node fixtures have two or more nodes. ColorPlay 3 automatically 
assigns a sequence of starting DMX addresses to each fixture node. When you 
change the fixture’s starting DMX address, ColorPlay 3 automatically updates 
the addresses for all subsequent nodes in the fixture.

	 When you move the pointer over a multiple-node fixture on the Patch Layer, 
the individual nodes are highlighted. For example, the 2-foot ColorBlaze 
TRX in the illustration below has six nodes, and is set to 16-bit RGBAW. Each 
node uses 10 consecutive DMX addresses for a total of 60. The fixture’s 
starting DMX address is 1; node 3, which uses DMX addresses 21 through 30, 
is highlighted.

	 Accent Powercore, Accent Compact, and ColorBlaze fixtures have variable 
node counts. Icons for these fixtures use the maximum node counts. If 
you’re using these fixtures at lower node counts, use the correct number of 
Rectangular Fixture icons or other single-node fixture icons instead.

3.	 Continue adding fixtures to your light map, as needed:

•	 You can continue double-clicking icons in the Fixture Palette, or dragging 
them to the mapping area, as described in step 2.

•	 You can duplicate fixtures by copying and pasting them. Click a fixture to 
select it, or hold the Ctrl key while clicking to select multiple fixtures. Select 
Edit>Copy, then Edit>Paste. Fixtures are assigned to the next available 
starting DMX addresses in order.
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Changing a Fixture Node Type
Some fixtures, such as ColorBurst Powercore, ColorReach Powercore, and 
ColorBlast TR, can operate in both 8-bit and 16-bit mode. Fixtures such as 
ColorBlast TRX and ColorBlaze TRX can also accept both three-channel RGB input 
and five-channel RGBAW input. The node types assigned to fixtures in your light 
map must match the configuration of the fixtures in your lighting installation.

To change a fixture node type:

1.	 Select a fixture.

2.	 In the Properties panel, select a node type from the Node Type list. Make sure 
that the node type you select is supported by the fixture.

Changing DMX Starting Addresses and Universe 
Assignments
After adding fixtures to your light map, you can change their starting DMX 
addresses and universe assignments.

Remember that the DMX addresses in your light map must match the addressing 
of your lighting installation. However, node addresses are not used to determine 
the node order for effects. Instead, node order for effects is determined by a 
group’s node pattern, the effect itself, or a combination of the two.

To change starting DMX addresses and universe assignments:

1.	 Select a fixture on the light map, then enter a new Node DMX starting address 
in the Fixtures Property Panel. 
 
Although the range of DMX addresses in a universe is 1 – 512, the highest 
starting DMX address you can assign depends on how many addresses a 
fixture requires. For instance, the highest starting DMX address you can assign 
to a single-node 8-bit RGB fixture is 510, because the fixture requires three 
consecutive DMX addresses (510, 511, 512). The highest starting DMX address 
you can assign to an 18-node 16-bit RGBAW fixture is 333, because the fixture 
requires 180 consecutive DMX addresses (333 through 512).

2.	 If necessary, change the universe assignment of a fixture by doing one of 
the following:

•	 Select a fixture on the light map, then select a universe assignment from 
the Port list in the Properties Panel.

•	 Select a fixture in the Patch layer, and then select Edit>Cut. Click the 
tab for the universe to which you want to assign the fixture, then select 
Edit>Paste.

Resolving DMX Addressing Conflicts
A red warning triangle appears on each DMX address to which more than one 
fixture has been assigned. This warning is informational only, as some lighting 
schemes call for certain (or all) nodes to have the same addresses. Your light 
shows display properly as long as the addressing in your light map and your 
lighting installation match.

In the illustration below, for example, two ColorBlast TRX fixtures are assigned 
to the same set of DMX addresses. If this is not the way you want your fixtures to 
be addressed, drag one ColorBlast TRX fixture to a set of DMX addresses that are 
currently not in use.

Changing Starting DMX Addresses for 
ColorGraze Powercore

ColorGraze Powercore fixtures have 
individually addressable 1-foot nodes 
or segments: the 2-foot fixture has 
two addressable nodes, and the 4-foot 
fixture has four. You can address a 
ColorGraze Powercore fixture using a 
starting DMX address for its first node, 
like any other fixture. You can also give 
each fixture node its own starting DMX 
address.

To address ColorGraze Powercore nodes 
individually, click the Select Node Group 
icon. Double-click the node you want to 
readdress, then drag it to a new starting 

DMX address. For identification 
purposes, a color-coded band 

appears at the top of each fixture 
node when nodes are addressed non-
consecutively.

The illustration below shows a 
portion of a light map with two 4-foot 
ColorGraze Powercore fixtures, each 
node of which is addressed individually. 
One fixture is color-coded purple, and 
the other green.
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Changing a Fixture’s Dimming Curve
Many 8-bit LED lighting fixtures from Color Kinetics have a built-in dimming curve 
(Normal, or CK Gamma) that ensures smooth fading down to and up from black. 
For many fixtures with 16-bit operation, the dimming curve is always linear in 
16-bit mode. Some fixtures, such as ColorBlast TRX and ColorBlaze TRX, offer the 
ability to set different dimming curves using on-board controls.

To support installations that contain a mixture of fixture types, ColorPlay 3 lets 
you explicitly assign dimming curves to individual fixtures:

•	 Linear No dimming curve is applied to the ColorPlay 3 data (applied 
by default)

•	 Normal (CK Gamma) The non-linear (gamma) dimming curve used in most 
Color Kinetics LED lighting fixtures.

•	 Tungsten/Incandescent A non-linear dimming curve that emulates the 
dimming curve of incandescent lamps on a DMX dimmer. This curve offers the 
most control at low intensities.

If a fixture has no dimming curve of its own, assigning a dimming curve in ColorPlay 3 
applies dimming behavior to that fixture. If a fixture has its own dimming curve, the 
behavior of the ColorPlay 3 dimming curve is added to the behavior of the dimming 
curve on the fixture itself. To avoid unexpected results, make sure you understand 
how dimming curves interact in such situations.

For example, an installation contains both ColorGraze Powercore and iColor Flex LMX 
fixtures. ColorGraze is 16-bit-capable, and its dimming curve is always linear in 16-bit 
mode. iColor Flex LMX is 8-bit only, and its dimming curve is always CK gamma. To 
ensure that the dimming curves of these two fixtures produce consistent behavior in 
your light show, set the dimming curve of each fixture in ColorPlay 3 to compensate 
for the differences between them. Assign the Linear dimming curve to the iColor Flex 
LMX fixtures, and the Normal curve to the ColorGraze fixtures. When you render your 
show, all fixtures should produce the same dimming behavior (normal + linear).

To set a fixture’s dimming curve:

1.	 Select a fixture.

2.	 In the Properties panel, select a dimming curve from the Fixture Curve list.

Renaming or Deleting Fixtures
By default, fixture names are the fixture types. For example, every ColorBlast 6 fixture 
you add to your light map is named ColorBlast 6. You can rename fixtures in the 
Fixtures Property Panel to further distinguish them, to match naming conventions in 
your lighting system design, and so on.

To rename fixtures:

Select a fixture in the mapping area, click the Name property, and enter a new name.

To delete fixtures:

Select one or more fixtures in the mapping area, and click Edit>Delete, or press the 
Delete key.
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Importing and Exporting Fixture 
Information
You can export fixture information from a light map to a .CSV (comma-separated 
value) file, or import fixture information from a .CSV file to a light map. As 
applicable for each fixture on a light map, exported information includes:

•	 Serial number

•	 Starting DMX address

•	 Fixture type

•	 Controller

•	 IP address

•	 Fixture name

•	 Manufacturer

•	 X and Y coordinates of fixture icon on Fixtures Layer

•	 Port (universe)

•	 Starting DMX address of each node

•	 Node type

To export fixture information from a light map:

1.	 Select File>Export Fixture Information.

2.	 Specify a file a name and location, and then click Save.

To import fixture information to a light map:

1.	 Select File>Import Fixture Information.

2.	 Select a .CSV file containing exported fixture information, and then click Open.
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4	 Groups

Once you’ve created your light map, you can start creating groups. Groups are virtual 
sets of light nodes to which you can assign effects. A group can include a single 
node or fixture, all the nodes or fixtures in your installation, or a partial set of nodes 
or fixtures.

Groups assign a node order to the nodes that they contain. The node order of a group 
modifies the behavior of effects for which the sequencing of nodes matters—Chasing 
Node, Sweep Node, and Streak. ColorPlay 3 offers six built-in node order schemes, or 
you can create your own custom node order.

For effects where node order matters, the node order of a group overrides the 
DMX addressing scheme of the light map. All other effects treat the set of nodes in 
a group as a virtual grid. For these effects, direction of movement is determined by 
effect properties.

Many light shows require only a few groups at the most. Intricate shows requiring 
many groups can become complex very quickly, so it’s a good idea to have a basic 
understanding of group and effect behavior before attempting to create complex 
light shows.

Adding Groups to a Light Map
Groups create virtual sets of light nodes. Groups can include one or more nodes or 
fixtures. Groups can overlap, and they can include some nodes of a multiple-node 
fixture while exlcuding other nodes from the same fixture.
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To add groups to a light map:

1.	 Click the Groups tab to open the Groups Layer, or choose Layer>Groups.

2.	 Double-click a group icon in the Element Picker, or drag a group icon to the 
mapping area.

3.	 Drag the group over one or more nodes. If necessary, use the resize handles to 
change the shape and size of the group.

A group can include a set of adjacent lights . . . A group can include lights in different locations. . .

A group can include some of a fixture’s nodes  
while excluding others. . .

Circular groups are convenient for unusual fixture 
layouts . . .

Setting the Node Order of a Group
Each group assigns a node order to the nodes that they contain. The node order 
of a group modifies the behavior of effects for which node sequencing matters—
Chasing Node, Sweep Node, and Streak. ColorPlay 3 offers six built-in node order 
schemes. You can change the starting point of each node order. You can also 
create your own custom node order.

E For effects where node order 
matters, the node order of 
a group overrides the DMX 
addressing scheme.
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To set the node order of a group:

1.	 Move the pointer to the upper left corner of a group. The Node Order Palette 
is displayed.

2.	 By default, the group node order is set to Horizontal Snake. To change node order:

	 Click the Node Order Palette to step through the six built-in node order schemes. 
By clicking different corners of the palette, you can change the starting position 
and direction of the node orders. For instance, you can set Vertical Skip to move 
down each column from left to right, down each column from right to left, up each 
column from left to right, or up each column from right to left. These variations 
are shown in the figure below.

	

Move down 
each column, 
from left 
to right.

Move down 
each column, 
from right 
to left.

Move up each 
column, from 
left to right.

Move up each 
column, from 
right to left.

Node order is immediately applied to the group.

3.	 To create your own custom node order, click the Change Node Order tool. The 
group whose node order you’re modifying turns blue.

	 Click the nodes in the order you want them. Note that the numbers represent 
the order of nodes in sequence within the group, not DMX addresses.

	 Groups with custom node orders are shown with the Custom Node Order icon.

Excluding Nodes from a Group
You can exclude selected nodes from a group. If you have overlapping groups, you can 
use this technique to display different effects on adjacent nodes.

•	 To exclude individual nodes from a group, click the Exclude Nodes From Group 
tool. Then click the nodes you want to exclude.

	 Excluded nodes turn black, and remaining nodes are renumbered according to 
the selected node order.

•	 To restore excluded nodes to a group, right-click a group, and select Include All 
Covered Lights from the pop-up menu.

Horizontal Snake

Whole Column

Whole Row

Vertical Skip

Horizontal Skip

Vertical Snake

Change Node Order tool

Custom Node Order

Exclude Nodes From Group tool
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Combining and Uncombining Groups
You can combine two or more groups to control nodes in unusual and non-
contiguous arrays.

To combine groups:

1.	 Select two or more groups.

2.	 Right-click, and select Combine from the pop-up menu. The resulting group 
has default properties, such as name (Group 2, for example) and node order 
(Horizontal Snake). Intersections (areas of overlap) are excluded from the 
combined group.

When you combine overlapping groups... ...the combined group excludes intersections.

You can also combine non-contiguous groups.
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To separate a combined group:

1.	 Select a combined group.

2.	 Right-click, and select Uncombine from the pop-up menu. Individual groups 
are restored, with the properties that were assigned to them before they were 
combined into a single group.
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5	 Effects

In combination with the Timeline, effects are the essence of a light show. They 
define the light output for each node or fixture in your lighting installation, and 
how that light output changes.

About Effects
ColorPlay 3 offers many effects, ranging from simple Fixed Color, Cross Fade, and 
Random Color Effects to complex Ripple, Particle, and Video effects. A light show can be 
simple, consisting of one or two effects, or it can be intricate, containing multiple stacked 
and overlapped effects.

Previewing and Simulating Effects
You can preview and simulate effects on the Effects layer. Preview and simulation 
can give you a general and often a very good sense of how an effect will appear 
on an installation of lights. The end result—the actual appearance of your light 
show—is subject to a number of factors, including the positioning and aiming of 
your lighting fixtures, additional ambient lighting if any, the size and dimensions of 
the installation space, the distance and angles of lighting fixtures to viewers, and 
so on. Additionally, complex effects with an intricate interplay of properties cannot 
be fully simulated on the Effects layer. In fact, the only way to accurately evaluate 
the appearance of effects in a light show is to preview the show on a mockup or 
actual lighting installation.

The Live Play feature lets you play a show on a set of lights before saving the 
show and downloading it to iPlayer 3. If you have access to lights, you can use Live 
Play to preview show effects as you create and modify them. See Chapter 6 for 
instructions on how to use Live Play.

Effects and Node Order
Some effects use the node order of a group to set the pattern or direction of an 
effect. These include the Chasing Node, Sweep Node, and Streak effects. When 
using these effects, make sure you set the group’s node order appropriately, as 
described in Chapter 4.
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For effects that display the same output on all nodes simultaneously, the node 
order of a group is irrelevant. These include the Fixed Color, Cross Fade, Color 
Wash, and Random Color effects. Node order is also irrelevant for effects that 
overlay the entire grid of nodes in a group. These include the Chasing, Sweep, 
Sparkle, Spiral, Burst, Image Fade, Video, Text, Strobe, Particle, and Colored 
Bars effects.

Effect Stacking and Transparency
You can stack multiple effects in a group using the timeline rows. An effect has 
priority over effects below it. If there are gaps in an effect, or if the effect has 
transparency, effects stacked below it “show through.” When defining colors for 
an effect, you can create transparency by setting opacity to less than 100%. Many 
effects let you make the foreground colors transparent so that any effects beneath 
them in the stack show through the ripple or particle patterns.

Chapter 6 covers effect stacking with the timeline. You need to understand effect 
stacking to use modifier effects, which alter the appearance of other effects.

Modifier Effects
ColorPlay 3 contains five modifier effects, the Constant Modifier, Wave Modifier, 
Fade In Out Modifier, RGB Range Modifier, and Perlin Noise Modifier effects. 
Modifier effects differ from other effects, as they are not used alone but in 
conjunction with other effects in a group. When you add a modifier effect to a 
group’s effect stack, it modifies all effects underneath it in the stack, so long as the 
effects have some transparency. If you want a modifier effect to modify all effects 
in a group, position the modifier effect at the top of the group’s effect stack.

ColorPlay 3 Effects and Properties
You can choose from 24 effects, including Chasing Node, Sweep Node, and Video 
effects, and five modifier effects.

Each effect has a set of properties, some of which are editable and some of which 
are view-only. You can modify the editable properties using the Properties Panel 
or Properties Disc, depending on the effect.

Fixed Color

Cross Fade

Color Wash

Chasing

Chasing Node

Sweep

Sweep Node

Sparkle

Streak

Spiral

Burst

Random Color

Image Fade

Video

Text

Strobe

Ripple

Particle

Colored Bars

Constant Modifier

Wave Modifier

Fade In Fade Out Modifier

RGB Range Modifier

Perlin Noise Modifier
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Fixed Color
Fixed Color displays a single solid color simultaneously on all fixtures 
in a group.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In 
property. You change the color using the Palette Editor.

Fade Out Duration of fade out to the color selected in the Fade Out Color 
property (HH:MM:SS).

Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

Base Color The fixed color to display. You change the color using the 
Palette Editor.

E Each second of an effect contains 
40 frames (1 frame = .025 seconds).

Entering Times in ColorPlay 3

A number of properties in ColorPlay 
3, including Start, Duration, End, and 
Static Index, take time values. For 
convenience, you can enter time values 
in a number of different ways. The 
following are all valid time entries.

 
12:12:12/2:03/:56.02

1s/1 sec/1 second/2secs

2.25m/2.25 min/2 minutes/2mins

2.25h/2.25 hr/2 hours/2hour

1d/1.5 days/1.112day

41f/41 frames

 
No matter how you enter time values, 
ColorPlay 3 displays them in day/hr/min/
sec format.
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Cross Fade
The Cross Fade effect creates a smooth transition from one solid color 
to a second solid color on all fixtures simultaneously.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Repeat The number of times to repeat the cross fade within the effect duration. 
For example, if Repeat is set to 1 and Duration is set to 1:00, the effect fades from 
the first color to the second color once in one minute. If Repeat is set to 3, the 
effect fades between the first and second color three times in one minute.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In 
property. You change the color using the Palette Editor.

Fade Out Duration of fade out to the color selected in the Fade Out Color 
property (HH:MM:SS).

Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

Loop If false, the effect abruptly jumps from the second color back to the first 
color at the end of each repeat and at the end of the effect. If true, smoothly fades 
from the second color back to the first color at the end of each repeat or the effect.

Palette The effect colors. You change and reorder the colors using the 
Palette Editor.

Effect fades from blue to green 
once over the entire effect 

duration, then jumps back to 
blue when effect repeats

Cross Fade Example 1
Duration: 1:00 | Repeat: 1 | Loop: false

Effect fades from blue to green 
once, then fades back to blue 

when the effect repeats

Cross Fade Example 2
Duration: 1:00 | Repeat: 1 | Loop: true

Fade from blue to green repeats 
three times within the total 

effect duration, jumping back to 
blue each time

Cross Fade Example 3
Duration: 1:00 | Repeat: 3 | Loop: false

Fade from blue to green 
repeats three times within the 

total effect duration, fading back 
to blue each time

Cross Fade Example 4
Duration: 1:00 | Repeat: 3 | Loop: true
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Color Wash
The Color Wash effect creates a smooth transition through a series of 
solid colors on all fixtures simultaneously.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Repeat The number of times to repeat the color wash within the effect duration. 
For example, if Repeat is set to 1 and Duration is set to 1:00, the effect transitions 
through the color sequence once in one minute. If Repeat is set to 3, the effect 
transitions through the color sequence three times in one minute.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In 
property. You change the color using the Palette Editor.

Fade Out Duration of fade out to the color selected in the Fade Out Color 
property (HH:MM:SS).

Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

Loop If false, the effect abruptly jumps from the last color in the sequence to the 
first color in the sequence at the end of each repeat and at the end of the effect. 
If true, smoothly fades from the last color in the sequence to the first color at the 
end of each repeat and at the end of the effect.

Palette The effect’s sequence of display colors. You add, change, reorder, and 
delete colors using the Palette Editor.

Effect transitions through a 
sequence of colors once, then 
jumps back to the first color 

when effect repeats

Color Wash Example 1
Duration: 1:00 | Repeat: 1 | Loop: false

Effect transitions through a 
sequence of colors once, then 
fades back to the first color 

when effect repeats

Color Wash Example 2
Duration: 1:00 | Repeat: 1 | Loop: true

The sequence of colors repeats 
three times within the total 

effect duration, jumping back to 
the first color each time

Color Wash Example 3
Duration: 1:00 | Repeat: 3 | Loop: false

The sequence of colors repeats 
three times within the total 

effect duration, fading back to 
the first color each time

Color Wash Example 4
Duration: 1:00 | Repeat: 3 | Loop: true
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Chasing
The Chasing effect creates bars of repeated color moving or “chasing” 
each other in one direction. You can change the angle, direction, and 
number of bars, as well as the apparent width of the bars.

The Chasing effect lays the effect colors over the entire grid of lights in a group, 
ignoring the fixture addresses and the group’s node pattern. To use the Chasing 
effect successfully, therefore, make sure that the layout of your lights matches or 
approximates the layout on your light map.

The illustration below shows three example installations, each with 16 lights, 
and each displaying the same Chasing effect (angle = 0, color width = 250). In the 
first example, the nodes are spaced evenly and addressed left to right and top 
to bottom. In the second example, the nodes are spaced evenly but addressed 
right to left and bottom to top. In the third example, the nodes are spaced and 
addressed randomly. In all three cases, the Chasing effect appears to sweep 

across the grid of lights from left to right.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Repeat The number of times the sequence of color bars chases across the grid 
of lights in a group for the specified duration. Use Repeat to increase the apparent 
chasing speed. For example, if Repeat is set to 1 and Duration is set to 1:00, the 
color bars chase across the grid once in one minute. If Repeat is set to 3, the color 
bars chase across the grid three times in one minute.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In 
property. You change the color using the Palette Editor.

Fade Out Duration of fade out to the color selected in the Fade Out Color 
property (HH:MM:SS).

Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.
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Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

Static If false, the color bars chase across the grid of fixtures. If true, the color 
bars appear to be paused at the frame specified in Static Index.

Static Index The frame in the effect to display when Static is True. You can enter 
a value in seconds, minutes, hours, days, or frames. The value is displayed in 
hours/mins/secs format. Since there are 40 frames per second, each frame is .025 
seconds. This duration is rounded to two places in the display (for instance, frame 
41 is displayed as 0:01.02 seconds).

Color Width The apparent width of the effect palette, in pixels. While Color 

Width does not refer to a measurable dimension in your installation, the apparent 
width of the color bars gives you a sense of how many fixtures each color 
bar covers.

The examples below show the effect of changing the color width in three grids of 

the same size. As the color width increases, each color bar covers a wider apparent 
portion of the grid.

Angle (deg) The apparent angle and direction in which the color bars chase each 
other. The angle determines the origin point of the color bars, beginning at 0 with 
vertical bars moving from left to right, and swinging counterclockwise through 
360 degrees.

Palette The sequence of color bars. You add, change, reorder, and delete color 
bars using the Palette Editor.

Color Width = 50 Color Width = 250 Color Width = 1000

Angle = 0 Angle = 45

Angle = 315
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Chasing Node
Like the Chasing effect, the Chasing Node effect displays bands of 
color that appear to move or “chase” each other in sequence. But 
instead of sweeping through a virtual area defined by a group, colors 
appear to chase each other from fixture to fixture or node to node, 

following the group’s currently selected node pattern. As described in Chapter 4, a 
group’s node pattern overrides the fixtures’ node addresses. This means that you 
can change the sequencing of the Chasing Node effect without re-addressing 
your fixtures.

The illustration below shows three example Chasing Node effects, each using 
three colors (red, orange, and yellow) and a different node pattern. Group 1 uses 

the Vertical Snake node pattern, Group 2 uses Horizontal Snake, and Group 3 uses 
Whole Row.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Repeat The number of times the sequence of colors appears to chase across the 
entire sequence of lights for the specified duration. Use Repeat to increase the 
apparent chasing speed. For example, if Repeat is set to 1 and Duration is set to 
1:00, the colors complete one circuit of the fixtures in one minute. If Repeat is set 
to 3, the colors complete three circuits in one minute.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In 
property. You change the color using the Palette Editor.

Fade Out Duration of fade out to the color selected in the Fade Out Color 
property (HH:MM:SS).

Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.
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Static If false, the colors chase across the sequence of nodes. If true, the colors 
appear to be paused at the frame indicated in the Static Index property.

Static Index The frame in the effect to display when Static is True. You can enter 
a value in seconds, minutes, hours, days, or frames. The value is displayed in 
hours/mins/secs format. Since there are 40 frames per second, each frame is .025 
seconds. This duration is rounded to two places in the display (for instance, frame 
41 is displayed as 0:01.02 seconds).

Reverse Direction If false, colors chase in the direction indicated by the group’s 
currently selected node pattern. If true, colors chase in the opposite direction.

Reverse Colors If false, colors chase through the node pattern in the order 
indicated in the Palette property. If true, colors chase through the node pattern in 
the opposite order.

Color Width The apparent width of the effect palette, in nodes. While Color 
Width does not refer to a measurable dimension in your installation, the apparent 
width of the color segment gives you a sense of how many nodes each color 
segment covers as it moves through the sequence.

In the examples below, the Color Width in Group 1 is set to 6. Notice how the 

three-color pattern recurs about halfway through the sequence of nodes. When 
Color Width is set to 35, as in Group 2, the three-color pattern covers the entire 
sequence of nodes. Group 3 is set to 100, extending the color pattern beyond the 
node length such that only two of the three effect colors are visible at a time.

Palette The sequence in which colors chase through the group’s currently 
selected node pattern. You add, change, reorder, and delete colors using the 
Palette Editor.
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Sweep
The Sweep effect is a progressive transition of one or more foreground 
colors across a solid background color in a sweeping motion.

The Sweep effect lays the effect colors over the entire grid of lights 
in a group, ignoring the fixture addresses and the group’s node pattern. To use 
the Sweep effect successfully, therefore, make sure that the layout of your lights 
matches or approximates the layout on your light map.

The illustration below shows three example installations, each with 16 lights, and 
each displaying the same Sweep effect (angle = 0, background color = yellow, and 
four foreground colors). In the first example, the nodes are spaced evenly and 
addressed left to right and top to bottom. In the second example, the nodes are 
spaced evenly but addressed right to left and bottom to top. In the third example, 
the nodes are spaced and addressed randomly. In all three cases, the Sweep effect 
appears to sweep across the grid of lights from left to right.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Repeat The number of times the sequence of foreground colors sweeps across 
the grid of lights for the specified duration. Use Repeat to increase the sweep 
speed. For example, if Repeat is set to 1 and Duration is set to 1:00, the foreground 
colors sweep across the grid once in one minute. If Repeat is set to 3, the 
foreground colors sweep across the grid three times in one minute.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In 
property. You change the color using the Palette Editor.

Fade Out Duration of fade out to the color selected in the Fade Out Color 
property (HH:MM:SS).

Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.
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Background Fade Percentage The degree of fade between the background 
color and the first foreground color. If set to 0, there is no fade, and the first 
foreground color appears abruptly.

Sweep Fade Percentage The degree of fade between each foreground color. If 
set to 0, there is no fade between foreground colors. If set to 100, the fade affects 
about half of each color’s apparent width.

In the example on the left, both Background Fade Percentage and Sweep Fade 
Percentage are set to 0. There is no blending between the colors, and they appear 

abruptly as the effect sweeps across the grid of nodes. In the example on the right, 
both properties are set to 100, so the colors gradually fade into each other as the 
effect sweeps across the nodes.

Angle (deg) The apparent angle and direction in which the foreground colors 

sweep across the background color. The angle determines the origin point of the 
foreground color segments, beginning at 0 with vertical segments moving from 
left to right and swinging counterclockwise through 360 degrees.

FG Mixing Ignores BG When true and a foreground color has transparency 
(opacity is less than 100%), the foreground color ignores the background color and 
mixes with the colors of any effect below it in the stack. When there is no effect 
below it, the foreground color mixes with black. When false and a foreground color 
has transparency, the foreground color mixes with the background color.

Background Color The background color across which the foreground colors 
appear to sweep. You change the background color using the Palette Editor.

Palette The sequence of one or more foreground colors, which appear to sweep 
across the background color. You add, change, reorder, and delete foreground 
colors using the Palette Editor.

Angle = 0 Angle = 45

Angle = 315
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Sweep Node
Like the Sweep effect, the Sweep Node effect displays a progressive 
transition of one or more foreground colors across a solid background 
color. But instead of sweeping over the entire grid of lights in a group, 
the foreground colors transition from fixture to fixture, following the 

group’s currently selected node pattern. As described in Chapter 4, you can select 
different node patterns to change the effect sequencing without modifying the 
effect or re-addressing your fixtures.

The illustration below shows three example Sweep Node effects, each using yellow 
as the background color, the same four foreground colors (red, orange, and blue), 
and a different node pattern: Vertical Snake for Group 1, Horizontal Snake for 
Group 2, and Whole Row for Group 3.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Repeat The number of times the sequence of foreground colors sweeps across 
the sequence of lights for the specified duration. Use Repeat to increase the sweep 
speed. For example, if Repeat is set to 1 and Duration is set to 1:00, the foreground 
colors complete one circuit of the fixtures in one minute. If Repeat is set to 3, the 
foreground colors complete three circuits in one minute.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In 
property. You change the color using the Palette Editor.

Fade Out Duration of fade out to the color selected in the Fade Out Color 
property (HH:MM:SS).

Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

Background Fade Percentage The degree of fade between the background 
color and the first foreground color. If set to 0, there is no fade, and the first 
foreground color appears abruptly.
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Sweep Fade Percentage The degree of fade between each foreground color. If 
set to 0, there is no fade.

In the example on the left, both Background Fade Percentage and Sweep Fade 
Percentage are set to 0. There is no blending between the colors, and they appear 
abruptly as the effect sweeps across the grid of nodes. In the example on the right, 
both properties are set to 100, so the colors gradually fade into each other as the 

effect sweeps across the nodes.

Reverse Direction If false, the foreground colors colors sweep in the direction 
indicated by the group’s currently selected node pattern. If true, the foreground 
colors sweep in the opposite direction.

Reverse Colors If false, the foreground colors sweep through the node pattern 
in the order indicated in the Palette property. If true, the foreground colors sweep 
through the node pattern in the opposite order.

FG Mixing Ignores BG When true and a foreground color has transparency 
(opacity is less than 100%), the foreground color ignores the background color and 
mixes with the colors of any effect below it in the stack. When there is no effect 
below it, the foreground color mixes with black. When false and a foreground color 
has transparency, the foreground color mixes with the background color.

Background Color The background color across which the foreground colors 
appear to sweep. You change the background color using the Palette Editor.

Palette The sequence of one or more foreground colors which appear to sweep 
across the background color. You add, change, reorder, and delete foreground 
colors using the Palette Editor.
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Sparkle
The Sparkle effect flashes one or more foreground colors at random 
intervals over a solid-color background, producing a sparkling visual 
effect. Foreground colors flash on and then fade. The Sparkle effect 
ignores fixture addresses and group node order.

The following example uses three iColor Module FX fixtures to create a grid of 108 
evenly spaced nodes. The background color is yellow, and the sparkle colors are 
red, blue, and green. Intermediate colors appear as each sparkle fades.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In 
property. You change the color using the Palette Editor.

Fade Out Duration of fade out to the color selected in the Fade Out Color 
property (HH:MM:SS).

Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

Density The number of sparkles per time period, from 0.00 (no sparkles) to 1.00 
(the maximum number of sparkles).

Lifetime The duration of each sparkle, from initial flash through fade-out, in 
frames. If Lifetime is greater than the total number of frames in the effect, the 
sparkles will not fade out completely before the effect repeats.
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FG Mixing Ignores BG When true and a foreground color has transparency 
(opacity is less than 100%), the foreground color ignores the background color and 
mixes with the colors of any effect below it in the stack. When there is no effect 
below it, the foreground color mixes with black. When false and a foreground color 
has transparency, the foreground color mixes with the background color.

Background Color The background color over which the foreground colors flash. 
You change the background color using the Palette Editor.

Palette The palette of one or more sparkle colors which flash over the 
background color. You add, change, and delete sparkle colors using the 
Palette Editor.
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Streak
In the Streak effect, one or more narrow bands of color move across a 
solid background, following the group’s currently selected node 
pattern. As described in Chapter 4, you can select different node 
patterns to change the effect sequencing without modifying the effect 

or re-addressing fixtures.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Repeat The number of times each streak completes a circuit of the fixtures for 
the specified duration. Use Repeat to increase the streak speed. For example, if 
Repeat is set to 1 and Duration is set to 1:00, streaks complete one circuit of the 
fixtures in one minute. If Repeat is set to 3, streaks complete three circuits in 
one minute.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In 
property. You change the color using the Palette Editor.

Fade Out Duration of fade out to the color selected in the Fade Out Color 
property (HH:MM:SS).

Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

Streak Width The number of nodes each streak covers. A wider streak displays 
more intermediate shades where the colors blend. For example, both streaks 
below use three colors (red, blue, and yellow) and a white background. The streak 
on the left, which is set to a width of 10, shows three or four intermediate shades 

between the three streak colors. The streak width on the right, which is set to 20, 
shows eight or nine intermediate shades between the streak colors.

If the streak width is less than the total number of palette colors, the additional 
colors are not shown. For example, if Streak Width were set to 2 in the above 
examples, only the first two streak colors (red and blue) would display, and the 
third streak color (yellow) would not display.

Streak Count If Loop is true, Streak Count is the number of streaks displayed on 
the fixtures simultaneously. If Loop is false, Streak Count is the number of streaks 
that travel across the grid of nodes in a single repeat.
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Wrap Use Wrap when Repeat is set to 2 or greater. If Wrap is false, each set of 
streaks leaves the grid entirely before the set repeats. If Wrap is true, each streak 
begins to reappear at the beginning of the sequence of nodes as it exits the end of 
the sequence.

Note that Wrap applies only to repeats within the effect; you use the Loop 
property to modify the way the effect itself repeats.

Reverse If false, streaks move in the direction indicated by the group’s currently 
selected node pattern. If true, the streaks move in the opposite direction.

Leading Edge If true, the first streak fades in over the background color as it 
moves through the node pattern. If false, the first streak color does not fade into 
the background color.

Trailing Edge If true, the the last streak color fades into the background color as 
it moves through the node pattern. If false, the last streak color does not fade into 
the background color.

Loop Applies the Wrap behavior to the entire effect. To use Loop, Repeat must 

be 2 or greater, and Wrap must be true.

FG Mixing Ignores BG When true and a foreground color has transparency 
(opacity is less than 100%), the foreground color ignores the background color and 
mixes with the colors of any effect below it in the stack. When there is no effect 
below it, the foreground color mixes with black. When false and a foreground color 
has transparency, the foreground color mixes with the background color.

Background Color The background color across which the streaks appear to 
move. You change the background color using the Palette Editor.

Palette The sequence of one or more streak colors which appear to move across 
the background color. You add, change, reorder, and delete streak colors using the 
Palette Editor.

When Wrap is true, streaks reappear 
at the beginning of the grid . . . . . . as they exit the grid

When Wrap is false, streaks do not reappear 
at the beginning of the grid until they have 
completely exited the grid

When Leading Edge and Trailing Edge 
are false, the first and last streak 

colors do not fade

When Leading Edge and Trailing Edge 
are true, the first and last streak 

colors fade into the background color
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Spiral
The Spiral effect produces arcs of color originating from a central point 
and moving across a grid of nodes in a clockwise or 
counterclockwise direction.

The Spiral effect lays the spiral colors over the entire grid of lights 
in a group, ignoring the fixture addresses and the group’s node pattern. To use 
the Spiral effect successfully, therefore, make sure that the layout of your lights 
matches or approximates the layout on your light map.

The illustration below shows three example installations, each with 16 lights, and 
each displaying the default Spiral effect. In the first example, the nodes are spaced 
evenly and addressed left to right and top to bottom. In the second example, the 
nodes are spaced evenly but addressed right to left and bottom to top. In the third 
example, the nodes are spaced and addressed randomly. In all three cases, the 

spiral appears to emerge out of a central point and sweep clockwise over the grid 
of lights.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Repeat The number of times the spiral makes one complete revolution in the 
specified duration. Use Repeat to increase the spiral speed. For example, if Repeat 
is set to 1 and Duration is set to 1:00, the spiral makes one complete revolution 
in one minute. If Repeat is set to 3, the spiral completes three revolutions in 
one minute.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In 
property. You change the color using the Palette Editor.

Fade Out Duration of fade out to the color selected in the Fade Out Color 
property (HH:MM:SS).

Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.
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Static If false, the spiral revolves across the sequence of nodes. If true, the spiral 
appears to be paused at the frame specified in Static Index.

Static Index The frame in the effect to display when Static is True. You can enter 
a value in seconds, minutes, hours, days, or frames. The value is displayed in 
hours/mins/secs format. Since there are 40 frames per second, each frame is .025 
seconds. This duration is rounded to two places in the display (for instance, frame 
41 is displayed as 0:01.02 seconds).

Radius The apparent width of the spiral arms. The default radius is 100. Enter 
a smaller number to make the spiral tighter, or a larger number to make the 
spiral broader.

Center X and Center Y The center is the point out of which the spiral appears to 
emerge. By default, the center is at 0,0.

Move the center to the right by giving Center X a positive number of pixels, or to 
the left by giving Center X a negative number.

Move the center up by giving Center Y a negative number of pixels, or down by 
giving Center Y a positive number.

Arm Count The number of arms in the spiral, per color. By default, Arm Count 
is 1.

Reverse If false, the spiral turns clockwise. If true, the spiral 
turns counterclockwise.

Palette The sequence of spiral arm colors. You add, change, reorder, and delete 
spiral arm colors using the Palette Editor.

Center X = 0
Center Y = 0

Center X = 100
Center Y = -50

Arm Count = 1 Arm Count = 3
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Burst
The Burst effect produces concentric rings of color moving either 
towards the edge of a group or towards a defined focal point.

The Burst effect lays the burst colors over the entire grid of lights in a 
group, ignoring the fixture addresses and the group’s node pattern. To 

use the Burst effect successfully, therefore, make sure that the layout of your lights 
matches or approximates the layout on your light map.

The illustration below shows three example installations, each with 16 lights, and 
each displaying the default Burst effect. In the first example, the nodes are spaced 
evenly and addressed left to right and top to bottom. In the second example, the 
nodes are spaced evenly but addressed right to left and bottom to top. In the third 
example, the nodes are spaced and addressed randomly. In all three cases, the 
burst pattern appears to emerge out of a central point and move towards the outer 
edge of the group.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End property 
resizes the effect on the timeline and automatically updates the Duration property.

Repeat The number of times the burst pattern completes one cycle in the 
specified duration. Use Repeat to increase the burst speed. For example, if Repeat 
is set to 1 and Duration is set to 1:00, the burst pattern completes one cycle in one 
minute. If Repeat is set to 3, the burst pattern completes three cycles in one minute.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In property. 
You change the color using the Palette Editor.

Fade Out Duration of fade out to the color selected in the Fade Out Color property 
(HH:MM:SS).

Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in the 
timeline). Changing the row changes the effect’s priority in a stack, assigns the effect 
to a different group, or unassigns the effect.

Static If false, the burst pattern moves across the group. If true, the burst pattern 
appears to be paused at the frame specified in Static Index.

1
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16
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40
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Static Index The frame in the effect to display when Static is True. You can enter a 
value in seconds, minutes, hours, days, or frames. The value is displayed in hours/
mins/secs format. Since there are 40 frames per second, each frame is .025 seconds. 
This duration is rounded to two places in the display (for instance, frame 41 is 
displayed as 0:01.02 seconds).

Radius The apparent width of the burst rings. The default width is 250. Enter 
a smaller number to make the rings tighter, or a larger number to make the 
rings wider.

Center X, Center Y, Focal Point X, Focal Point Y The focal point is the emergence 
or convergence point of the burst rings. The center is a secondary focal point that 
you can use to extend the burst rings in an ellipse in any direction.

By default, Center X, Center Y, Focal Point X, and Focal Point Y are all 0. To move 
the emergence/convergence point while keeping the rings circular, change Center 
X and Focal Point X to the same value, and Center Y and Focal Point Y to the same 
value. To make the rings elliptical, enter different values for the Focal Point and 
Center properties.

Move the center or focal point to the right of the origin by entering a positive 
number of pixels, or to the left by entering a negative number. Move the center or 
focal point above the origin by entering a negative number of pixels, or below the 
origin by entering a positive number.

Reverse If false, the burst pattern appears to emerge from the focal point. If true, 
the burst pattern appears to converge toward the focal point.

Palette The sequence of burst ring colors. You add, change, reorder, and delete 
burst ring colors using the Palette Editor.

Radius = 250 Radius = 100

Focal point and center  
offset, rings circular 

Center only offset,  
rings elliptical 

Focal point and center offset,  
rings elliptical 

Focal Point 100,50
Center 100,50 Focal Point 0,0

Center 100,-50
Focal Point 0,0

Center 100,-50
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Random Color
The Random Color effect produces a sequence of two or more 
randomly generated solid colors simultaneously on all fixtures in 
a group.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Repeat The number of colors in the sequence of random colors.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In 
property. You change the color using the Palette Editor.

Fade Out Duration of fade out to the color selected in the Fade Out Color 
property (HH:MM:SS).

Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

Fade Time The relative length of time for the colors in the random sequence to 
fade into one another. Set Fade Time to 0 for no fade between colors.

Seed An automatically generated number used to generate the random color 
sequence, beginning with the base color. Using the same Seed value for multiple 
effects produces the same sequence of colors.

Base Color The first color in the sequence of random colors. You change the 
base color using the Palette Editor.
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Image Fade
The Image Fade effect produces a visual sequence in which one image 
fades gradually into a second image. You can change the starting and 
ending positions to make the fade sequence appear to travel along a 
vector. You can also change the starting and ending dimensions to 

make the fade sequence appear to gradually change size. The Image Fade effect 
accepts BMP, GIF, ICO, PNG, JPEG, JPG, MNG, PBM, PGM, PNG, PPM, SVG, TIF, TIFF, 
XBM, or XPM files.

The Image Fade effect lays the image sequence over the entire grid of lights in 
a group, ignoring the fixture addresses and the group’s node pattern. To use 
the Image Fade effect successfully, therefore, make sure that the layout of your 
lights matches or approximates the layout on your light map. To clearly display 
photographic or other detailed images, use a grid with a sufficient number of 
evenly spaced nodes. Direct-view lighting fixtures with multiple nodes, such as 
iColor Flex MX, iColor Flex LMX, iColor Flex SLX, iColor Tile FX, and iColor Accent 
Powercore, are especially suitable.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Repeat The number of times the fade sequence completes one cycle in the 
specified duration. Use Repeat to increase the sequence speed. For example, if 
Repeat is set to 1 and Duration is set to 1:00, the fade sequence completes one 
cycle in one minute. If Repeat is set to 3, the fade sequence completes three cycles 
in one minute.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In 
property. You change the color using the Palette Editor.

Fade Out Duration of fade out to the Fade Out Color property color (HH:MM:SS).

Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

Start Image The starting image for the effect. Enter a path to an image file (for 
example, C:\Documents and Settings\My Documents\clouds.jpg), or double-click 
the property value to browse and select an image.

Start X and Start Y Start X and Start Y set the initial position of the fade 
sequence. By default, Start X and Start Y are both set to 0, which aligns the left and 
top edges of the starting image with the left and top edges of the group to which 
the effect is assigned.

E You can Alt-click the Image 
Fade effect to toggle between the 
effect’s start and end frames.

E You can clear the starting and 
ending images by right-clicking on the 
effect and selecting Clear Start Image 
or Clear End Image from the pop-up 
menu.
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Entering a number of pixels for the Start X property shifts the initial position of the 
fade sequence to the right (positive number) or left (negative number). Entering 
a number of pixels for the Start Y property shifts the initial position of the fade 
sequence down (positive number) or up (negative number).

If End X and End Y are different from Start X and Start Y, the fade sequence 
appears to travel along a vector defined by the initial position of the starting image 
and the final position of the ending image.

Start Width and Start Height Start Width and Start Height determine the 
starting size of the fade sequence. By default, Start Width and Start Height are set 
by the pixel dimensions of the group to which the effect is assigned.

Entering a number of pixels for the Start Width property changes the starting 
width of the fade sequence. Entering a number of pixels for the Start Height 
property changes the starting height of the fade sequence.

If End Width and End Height are different from Start Width and Start Height, 
the fade sequence appears to morph smoothly from the starting size to the 
ending size.

End Image The ending image for the effect. Enter a path to an image file (for 
example, C:\Documents and Settings\My Documents\clearsky.jpg), or double-click 
the property value to browse and select an image. If no image is assigned, the 
starting image is also used as the ending image.

End X and End Y End X and End Y determine the final position of the fade 
sequence. By default, End X and End Y are both set to 0, which aligns the left and 
top edges of the ending image with the left and top edges of the group to which 
the effect is assigned.

Entering a number of pixels for the End X property shifts the final position of the 
fade sequence to the right (positive number) or left (negative number). Entering 
a number of pixels for the End Y property shifts the final position of the fade 
sequence down (positive number) or up (negative number).

If End X and End Y are different from Start X and Start Y, the fade sequence 
appears to travel along a vector defined by the initial position of the starting image 
and the final position of the ending image.

End Width and End Height End Width and End Height determine the ending size 
of the fade sequence. By default, End Width and End Height are set by the pixel 
dimensions of the group to which the effect is assigned.

When the starting and ending 
positions and dimensions are 
the same, the starting image 
fades into the ending image 
while remaining stationary.

When the starting and ending 
positions are different, the 
fade sequence appears to 

travel along a vector defined 
by the starting image’s Start X 

and Start Y  
values and the ending image’s  

End X and End Y values.

When both the starting and ending positions and dimensions are different, the fade sequence appears to travel along a vector 
defined by the starting image’s start position and the ending image’s end position, while smoothly morphing from the start image’s 
dimensions to the end image’s dimensions as the images fade into one another. Note that you can position images outside of the 
group boundaries, to make the fade sequence appear to emerge or disappear as it traverses the group. 
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Entering a number of pixels for the End Width property changes the ending width 
of the fade sequence. Entering a number of pixels for the End Height property 
changes the ending height of the fade sequence.

If End Width and End Height are different from Start Width and Start Height, 
the fade sequence appears to morph smoothly from the starting size to the 
ending size.

Softness The amount of blur applied to the fade sequence, from 0.00 (no blur) to 
1.00.

Fade to Transparent When set to True, fades the Start Image to transparent if 
no End Image is specified.

Video
The Video effect displays moving images from a digital video 
sequence. The Video effect can play any file type supported by 
QuickTime on your computer (for example, MOV, MPG, and MP4 files).

The Video effect lays the video sequence over the entire grid of lights in a group, 
ignoring the fixture addresses and the group’s node pattern. To use the Video 
effect successfully, therefore, make sure that the layout of your lights matches or 
approximates the layout on your light map. To clearly display video images, use a 
grid with a sufficient number of evenly spaced nodes. Direct-view lighting fixtures 
with multiple nodes, such as iColor Flex MX, iColor Flex LMX, iColor Flex SLX, iColor 
Tile FX, and iColor Accent Powercore, are especially suitable.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

If Duration is set to a length of time shorter than the duration of the selected video 
clip, the video clip plays from the beginning but is truncated. If Duration is set to 
a length of time longer than the duration of the selected video clip, the video clip 
plays all the way through, then the effect displays nothing until the effect repeats.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Repeat The number of times the video sequence completes one cycle in the 
specified duration. Use Repeat to increase the playback speed. For example, if 
Repeat is set to 1 and Duration is set to 1:00, the video sequence completes one 
cycle in one minute. If Repeat is set to 3, the video sequence completes three 
cycles in one minute.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In 
property. You change the color using the Palette Editor.

Fade Out Duration of fade out to the color selected in the Fade Out Color 
property (HH:MM:SS).

To clearly display video images, you 
achieve the best results using a grid 
with a sufficient number of evenly 

spaced nodes.
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Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

Video File The video clip for the effect. Enter a path to a video file (for example, 
C:\Documents and Settings\My Documents\demo.mov), or double-click the 
property value to browse and select a valid file.

Video Length The native duration of the selected video clip, for reference 
(not editable).

Video Width The native width of the selected video clip, for reference 
(not editable).

Video Height The native height of the selected video clip, for reference 
(not editable).

X and Y X and Y determine the position of the video. By default, X and Y are both 
set to 0, which aligns the left and top edges of the video image with the left and 
top edges of the group to which the effect is assigned.

Entering a number of pixels for the X property shifts the video to the right (positive 
number) or left (negative number). Entering a number of pixels for the Y property 
shifts the video down (positive number) or up (negative number).

Width and Height Width and Height determine the dimensions of the video. 
By default, Width is set to Video Width and Height is set to Video Height. Width 
and Height change the video dimensions independently; you can’t automatically 
maintain the video’s aspect ratio when resizing.

Video In Time Sets the point within the video clip at which to start playback 
(HH:MM:SS). (Keep in mind that the video starts playing at 00:00:00 of the effect.) 
If the video ends before the effect ends, the effect displays nothing for the 
remainder of the effect duration.

Video Out Time Sets the point within the video clip at which to end playback 
(HH:MM:SS). If Video Out Time occurs before the end of the video clip, the 
video clip is truncated, and the effect displays nothing for the balance of the 
effect duration.

Playback Rate The speed at which to play back the video clip. 1:00 (the default) is 
normal speed, 2:00 is twice normal speed, 0.50 is half normal speed, and so on.
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Text
The Text effect scrolls a text message across a solid background color, 
from right to left. The size of the background is determined by the size 
of the group (rather than the size of the grid of nodes).

The Text effect overlays the entire grid of lights in a group, ignoring the fixture 
addresses and the group’s node pattern. To use the Text effect successfully, 
therefore, make sure that the layout of your lights matches or approximates the 
layout on your light map. Use a grid with a sufficient number of evenly spaced 
nodes to ensure readability.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Repeat The number of times the text message scrolls across the background in 
the specified duration. Use Repeat to increase the scrolling speed. For example, if 
Repeat is set to 1 and Duration is set to 1:00, the text message scrolls across the 
background in one minute. If Repeat is set to 3, the text message scrolls across the 
background three times in one minute.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In 
property. You change the color using the Palette Editor.

Fade Out Duration of fade out to the color selected in the Fade Out Color 
property (HH:MM:SS).

Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

Text The text message to scroll across the background.

Font The typeface for the text message. Select from any font installed on the 
computer running ColorPlay 3.

Text Height The relative size of the type. Text Height is 0.9 by default. Larger 
numbers increase the size of the type (up to about 28.0), smaller numbers 
decrease it.

Center X and Center Y Center X starts the text motion further to the right 
(positive values) or left (negative values). Center Y offsets the text downward 
(positive values) or upward (negative values).

Level of Detail The relative resolution of the characters, from 0.00 (lowest 
resolution) to 1.00 (highest resolution). Level of Detail is 0.75 by default.

Softness The amount of blur applied to the type, from 0.00 (no blur) to 1.00.

To ensure readability, use a grid with 
a sufficient number of evenly spaced 

nodes.
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Antialiasing Antialiasing minimizes jagged artifacts at the edges of type. True 
applies antialiasing to the type. False turns antialiasing off.

FG Mixing Ignores BG When true and a foreground color has transparency 
(opacity is less than 100%), the foreground color ignores the background color and 
mixes with the colors of any effect below it in the stack. When there is no effect 
below it, the foreground color mixes with black. When false and a foreground color 
has transparency, the foreground color mixes with the background color.

Static If false, the text appears to chase across the sequence of nodes. If true, 
the text appears to be paused at the frame indicated in the Static Index property.

Static Index The frame in the effect to display when Static is True. You can enter 
a value in seconds, minutes, hours, days, or frames. The value is displayed in 
hours/mins/secs format. Since there are 40 frames per second, each frame is .025 
seconds. This duration is rounded to two places in the display (for instance, frame 
41 is displayed as 0:01.02 seconds).

Background Color The background color across which the text message scroll. 
You change the background color using the Palette Editor.

Palette The sequence of one or more colors to apply to the text. If you specify 
more than one color, the colors blend proportionally across the text from left to 
right. You add, change, reorder, and delete text colors using the Palette Editor.
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Strobe
The Strobe effect produces solid pulses of a foreground color over a 
background color. When the pulses are short in duration, the Strobe 
effect 
produces an intermittent flashing effect that emulates a strobe light.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Repeat The number of pulses, starting at the offset and equally spaced within 
the overall effect duration.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In 
property. You change the color using the Palette Editor.

Fade Out Duration of fade out to the color selected in the Fade Out Color 
property (HH:MM:SS).

Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

On Time The duration of each pulse, in seconds (0.25 seconds by default).

Offset How long to wait, in seconds, before starting the sequence of evenly 
spaced pulses.

Background Color The background color over which the strobe color appears. 
You change the background color using the Palette Editor.

Strobe Color The foreground color that pulses over the background color. You 
change the background color using the Palette Editor.
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Ripple
The Ripple effect displays rings of color moving over a solid 
background color. The Ripple effect lays the rings over the entire grid 
of lights in a group, ignoring the fixture addresses and the group’s 
node pattern. To use the Ripple effect successfully, therefore, make 

sure that the layout of your lights matches or approximates the layout on your 
light map.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In 
property. You change the color using the Palette Editor.

Fade Out Duration of fade out to the color selected in the Fade Out Color 
property (HH:MM:SS).

Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

FG Mixing Ignores BG When true and a foreground color has transparency 

(opacity is less than 100%), the foreground color ignores the background color and 
mixes with the colors of any effect below it in the stack. When there is no effect 
below it, the foreground color mixes with black. When false and a foreground color 
has transparency, the foreground color mixes with the background color.

Velocity The relative speed of the ring movement. The default value is 1.

Transparent FG is false  
(ring colors display) 

Transparent FG is true 
(rings are transparent) 

Transparent foreground, with 
Colored Bars effect beneath 
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Background Color The background color over which the rings appear to move. 
You change the background color using the Palette Editor.

Palette The set of one or more colors for the rings. You add, change, reorder, 
and delete text colors using the Palette Editor.

Particle

The Particle effect produces animated circular shapes of varying sizes 
over a solid background color. This effect simulates a particle system 
such as clouds, fire, or rain.

The Particle effect runs the particle pattern over the entire grid of lights in a group, 
ignoring the fixture addresses and the group’s node pattern. To use the Particle 
effect successfully, therefore, make sure that the layout of your lights matches or 
approximates the layout on your light map.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In 
property. You change the color using the Palette Editor.

Fade Out Duration of fade out to the color selected in the Fade Out Color 
property (HH:MM:SS).

Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

Fire Snow
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FG Is Color Under Effect Creates a transparent foreground for the Particle 
effect. By default, FG Is Color Under Effect is false, so the particles use the colors 
specified in the Palette property. If FG Is Color Under Effect is set to true, the 
particles become transparent. Stacked effects in the Timeline Editor below the 
Particle effect show through the transparent particles.

Density  Controls the quantity of particles produced by the effect. The default 
value is .5 within a range of 0 – 1.

Angle (deg) The apparent angle and direction in which the particles move across 
the background color. The angle (0 – 360) determines the origin point of the 
particles. At 0, particles move from left to right. Negative numbers shift the angle 
clockwise from 0, while positive numbers shift the angle counterclockwise from 0. 
The default angle is 90 degrees, with particles moving from the bottom to the top.

Velocity The relative speed of the particle movement. The default value is 1.

Particle Size The relative size of individual particles. The default value is .25 
within a range of 0 – 1.

Jitter Jitter creates random oscillations as particles move along their path. The 
default value is 5.

Decay The relative change in particle size over the duration of the effect. At the 
default value of .75 (within a range of 0 – 1), particles reduce by 100% in size over 
the duration of the effect.

Fade The degree to which the particles fade as they traverse the background. At 
the default value of 1 (within a range of 0 – 1), particles fade completely by the end 
of each effect cycle. At 0, particles do not fade, but abruptly disappear.

Effect Height The relative height of the effect—that is, how much of the group is 
covered by the effect. The default value is 1.

Background Color The background color over which the particles appear to 
move. You change the background color using the Palette Editor.

Palette The set of one or more colors for the particles. You add, change, and 
delete text colors using the Palette Editor.
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Colored Bars
The Colored Bars effect randomly displays bars of varying widths and 
colors over a solid background.

The Colored Bars effect overlays the entire grid of lights in a group, 
ignoring the fixture addresses and the group’s node pattern. To use the Colored 
Bars effect successfully, therefore, make sure that the layout of your lights 
matches or approximates the layout on your light map.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Fade In Duration of fade in from the color selected in the Fade In Color property 
(HH:MM:SS).

Fade In Color Color to fade in from, using the duration set in the Fade In 
property. You change the color using the Palette Editor.

Fade Out Duration of fade out to the color selected in the Fade Out Color 
property (HH:MM:SS).

Fade Out Color Color to fade out to, using the duration set in the Fade Out 
property. You change the color using the Palette Editor.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

FG Mixing Ignores BG When true and a foreground color has transparency 
(opacity is less than 100%), the foreground color ignores the background color and 
mixes with the colors of any effect below it in the stack. When there is no effect 
below it, the foreground color mixes with black. When false and a foreground color 
has transparency, the foreground color mixes with the background color.

Background Color The background color over which the colored bars appear. 
You change the background color using the Palette Editor.

Palette The set of one or more bar colors. You add, change, reorder, and delete 
text colors using the Palette Editor.
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Constant Modifier
The Constant Modifier effect applies a constant change to the hue, 
saturation, and/or brightness of all visible effects underneath it in a 
group. To apply the Constant Modifier effect to a group’s entire effect 
stack, 

make sure that the Constant Modifier effect is at the top of the stack.

You can use the Constant Modifier effect, for example, to change the saturation 
or brightness of the entire set of effects assigned to a group, or to color-shift the 
appearance of a Video effect.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

Hue Action and Hue Value None (no action) by default. To modify the hue of all 
visible effects underneath the Constant Modifier effect in a group’s effect stack, 
select Scale, Replace, or Offset, then give the Hue Value property a value.

The Constant Modifier effect uses a 360-degree color wheel to calculate hue 
modifications, with pure red (255,0,0) at 0°.

Scale Multiplies the angle of each hue by the specified Hue Value.

Replace Replaces each hue with the hue that lies at the angle on the color wheel 
specified in Hue Value (0 – 360).

Offset Adds the number of degrees specified in Hue Value (0 – 360) to each hue. 
Positive numbers offset hues clockwise around the color wheel, while negative 
numbers offset hues counterclockwise around the color wheel.

Saturation Action and Saturation Value None (no action) by default. To modify 
the saturation of the effects beneath the Constant Modifier effect in a group’s 
effect stack, select Scale, Replace, or Offset, then give the Saturation Value 
property a value.

Scale Multiplies the saturation percentage of each color by the specified 
Saturation Value. Entering a Saturation Value greater than 1 makes the colors 
controlled by the Constant Modifier effect appear more intense, while entering a 
value less than 1 makes the colors appear more pastel.

Replace Replaces the saturation of each color with the saturation percentage 
specified in Saturation Value (0 – 1).

Offset Changes the saturation of each color by the percentage specified in 
Saturation Value (0 – 1 or 0 – -1). Positive numbers increase saturation by the 
specified percentage, while negative numbers decrease saturation.
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Brightness Action and Brightness Value Scale by default. To modify the 
brightness of the effects beneath the Constant Modifier effect in a group’s effect 
stack, select Scale, Replace, or Offset, then give the Brightness Value property 
a value.

Scale Multiplies the brightness percentage of each color by the specified 
Brightness Value. Entering a Brightness Value greater than 1 makes the colors 
controlled by the Constant Modifier effect appear brighter, while entering a value 
less than 1 makes the colors appear dimmer.

Replace Replaces the brightness of each color with the brightness percentage 
specified in Brightness Value (0 – 1).

Offset Changes the brightness of each color by the percentage specified in 
Brightness Value (0 – 1 or 0 – -1). Positive numbers increase brightness by the 
specified percentage, while negative numbers decrease brightness.
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Wave Modifier
The Wave Modifier effect uses different wave patterns to vary the 
appearance of effects over time. With the Wave Modifier effect, you 
can vary the hue, saturation, or brightness of all effects underneath it 
in a group. To apply the Wave Modifier effect to a group’s entire effect 

stack, make sure that the Wave Modifier effect is at the top of the stack.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

Wave Mode You can select sine, square, or sawtooth wave shapes to achieve 
different variation profiles.

Sine  Smoothly ramps up to the maximum value, then smoothly ramps down to 
the minimum value

Square Jumps sharply to the maximum value and remains there for half a cycle, 
then drops sharply to the minimum value and remains there for half a cycle

Sawtooth Smoothly ramps up from the middle value to the maximum value 
halfway through the cycle, then drops sharply to the minimum value

HSV Mode Sets the effect to vary Hue, Saturation, or Brightness.

Repeat Wave The number of times the wave repeats within the 
specified duration.

Minimum Value Clips the minimum of the resulting modified signal to that value. 
For any duration in which the resulting modified signal falls below the specified 
Minimum Value, the signal will be changed to the specified value.

Maximum Value Clips the maximum of the resulting modified signal to that 
value. For any duration in which the resulting modified signal exceeds the specified 
Maximum Value, the signal will be changed to the specified value.

Y Axis Offset The underlying signal multiplied by the Y Axis Offset represents 
the starting value for the transformation.

Wave Amplitude Indicates the magnitude of change for scaling the original 
signal according to the selected Wave Mode.
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Fade In Out Modifier
The Fade In Out Modifier effect gradually fades in or fades out the 
saturation or brightness of all effects underneath it in a group. The 
effect can also gradually transition all colors through a range of hues.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

In/Out Mode For brightness and saturation, Fade In gradually fades from the 
Min Value to the Max Value, and Fade Out gradually fades from the Max Value to 
the Min Value.

For hue, Fade In gradually transitions clockwise around the color wheel through a 
range of hues, while Fade Out gradually transitions counterclockwise. The range 
of hues is defined by the effect colors in conjunction with the Min Value and the 
Max Value.

HSV Mode Sets the Fade In Out Modifier effect to modify Hue, Saturation, 
or Brightness.

Min Value and Max Value For brightness and saturation, Min Value is the 
minimum percentage of the effect color’s brightness or saturation, and Max Value 
is the maximum percentage of the effect color’s brightness or saturation.

For example, an effect displays a color at 50% brightness, Min Value is set to .1 
(10%), Max Value is set to .8 (80%), and In/Out Mode is set to Fade In. The Fade In 
Out Modifier begins at 10% of the effect color’s initial brightness (5% brightness) 
and gradually increases the brightness to 80% of the initial brightness (40% 
brightness).

For hue, Min Value and Max Value represent percentages of the distance, around 
the circumference of the color wheel, between the effect color’s angle and 0° (pure 
red). Fade In transitions counterclockwise through the range of colors defined by 
Min Value and Max Value, while Fade Out transitions clockwise.

For example, an effect displays a pure green color (0,255,0), which is at 180° on the 
color wheel. In/Out Mode is set to Fade In, Min Value is set to .25, and Max Value is 
set to .75. The effect begins at the color which is at 25% of the distance between 0° 
and 180° on the color wheel, moving counterclockwise from 0°. The effect ends at 
the color which is at 75% of that distance. Therefore, the effect transitions through 
the range of colors between 315° (a bright pink, 255,0,255) and 225° (a bright blue, 
17,151,255).
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RGB Range Modifier
The RGB Range Modifier effect sets limits on the red, green, and/or 
blue channels of all effects underneath it in a group. In Clip mode, 
channel values cannot be greater than the maximum value or less than 
the minimum value. In Expand mode, channel values above the 

maximum value are pushed to 255, while channel values below the minimum 
value are pushed to 0.

In Clip mode, for example, you can limit the brightness of your overall show by 
setting the same minimum and maximum value across all channels. (Setting 
different values for different channels will alter the hue of all effect colors in 
Clip mode.) In Expand mode, you can modify video with a compressed dynamic 
range to push the brightest colors to the maximum and the darkest colors to the 
minimum, resulting in brilliant light colors and deep dark colors.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

Range Mode Sets the effect to clip or expand RGB values.

Clip Channel values cannot be greater than the maximum value or less than the 
minimum value. Channel values above the maximum value are reduced to the 
maximum value, and channel values below the minimum value are raised to the 
minimum value. For example, if Min Red is set to 100 and Max Red is set to 200, all 
red channel values over 200 are reduced to 200, and all red channel values below 
100 are raised to 100.

Expand Channel values greater than the maximum value are pushed to 255, 
and channel values below the minimum value are pushed to 0. For example, if 
Min Red is set to 100 and Max Red is set to 200, all colors with red channel values 
above 200 are pushed to 255, and all colors with red channel values below 100 are 
pushed to 0.

Min Red The minimum value for the red channel (0 – 255).

Min Green The minimum value for the green channel (0 – 255).

Min Blue The minimum value for the green channel (0 – 255).

Max Red The maximum value for the red channel (0 – 255).

Max Green The maximum value for the green channel (0 – 255).

Max Blue The maximum value for the green channel (0 – 255).



	 ColorPlay 3  User Guide	 75

Perlin Noise Modifier
The Perlin Noise Modifier effect overlays a random, smooth-flowing 
pattern of noise over all effects underneath it in a group.

Effect Type Name of effect type (not editable).

Start Start time of effect on the timeline (HH:MM:SS). Editing the Start property 
shifts the effect on the timeline and automatically updates the End property.

Duration Duration of effect on the timeline (HH:MM:SS). Editing the Duration 
property resizes the effect on the timeline and automatically updates the 
End property.

End End time of effect on the timeline (HH:MM:SS). Editing the End 
property resizes the effect on the timeline and automatically updates the 
Duration property.

Row Timeline row to which the effect is assigned (row 1 is the topmost row in 
the timeline). Changing the row changes the effect’s priority in a stack, assigns the 
effect to a different group, or unassigns the effect.

Random Seed An automatically generated series of numbers that generates the 
random noise pattern.

Value Multiplier The height of the peaks in the Perlin noise pattern (default 

value is 1). Higher values make the minimum and maximum saturation and 
brightness values more extreme.

Frequency = 1 Frequency = 10

Value Multiplier = 1 Value Multiplier = 5

A Perlin noise pattern
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Frequency The apparent “roughness” of the Perlin noise pattern. The default 
frequency of 1 produces a fairly smooth pattern. Increasing the frequency creates 
a rougher or tighter pattern.

Speed The speed at which the Perlin noise pattern changes. The default is 1. 
Enter a larger number to increase the speed, or a fraction to decrease the speed. 
Entering 0 makes the pattern static (stops the pattern from changing).

Mode Sets the Perlin Noise Modifier effect to modify Hue, Saturation, 
or Brightness.

Action To modify the hue, saturation, or brightness of the effects underneath 
the Perlin Noise Modifier effect in a group’s effect stack, select Scale, Replace, or 
Offset. Selecting None turns noise generation off.

Scale For hue, the Perlin Noise Modifier effect uses a 360-degree color wheel to 
calculate hue modifications, with pure red (255,0,0) at 0°. Scale multiplies the angle 
of each hue by a random value.

For brightness and saturation, multiplies the brightness or saturation percentage 
of each color by a random value.

Replace For hue, replaces each hue with a hue calculated by the Value Multiplier.

For brightness and saturation, replaces the brightness or saturation of each color 
with a random percentage.

Offset For hue, adds a random number of degrees on the 360-degree color wheel 
to each hue. Positive numbers offset hues clockwise around the color wheel, while 
negative numbers offset hues counterclockwise around the color wheel.

For brightness and saturation, changes the brightness or saturation of each color 
by adding or subtracting a random percentage.
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Applying Effects to Groups
After creating the groups you need, you can apply effects to groups.

To apply an effect to a group:

1.	 Click the Effects tab, or choose Layer>Effects.

2.	 Do one of the following to assign effects to groups:

•	 Drag one of the 24 effect icons from the Effect palette to a group in the 
mapping area.

•	 Drag an effect icon to a timeline row in the timeline editor.

Once you’ve applied an effect, you can modify it and its placement on the timeline.

To cut-and-paste or copy-and-paste an effect:

1.	 To cut an effect, select the effect block in the timeline and select Edit>Cut. To 
copy an effect, select the effect block in the timeline and choose Edit>Copy.

2.	 Choose Edit>Paste. The effect is pasted at the end of the row from which it was 
cut or copied.

To delete an effect:

Select the effect block in the timeline and choose Edit>Delete or press Delete.

Modifying Properties
There are multiple techniques for editing the appearance and behavior of an effect: You 
can use the Properties Panel, the Palette Editor, the Properties Disc, or the effect 
block in the timeline editor.

Using the Properties Panel
Select an effect to display the effect’s property values in the Properties Panel. 
You can modify editable properties by double-clicking the property value, 
then entering a value, selecting a value from a list, or using the Palette Editor, 
depending on the property.

The Palette Editor
When a property calls for a color, you select the color using the Palette Editor. To 
display the palette editor, do one of the following:

•	 Double-click the relevant property in the Properties panel.

•	 Click the Color Palette Bar, located in the bottom left corner of an effect.

Color Palette Bar

The Palette Editor offers an RGB Range for picking colors, and a White Range for 
targeting of temperatures or tints of white light.

The Properties Panel, showing 
the properties for the Sparkle 

effect.

E When you assign an effect to a 
Single Channel fixture, only the Red 
channel is used.
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The RGB Range

The RGB Range lets you select a specific color using the Color Spectrum, Color 
Detail, and Color Field controls, or using the sliders for the RGB (red/green/blue) 
color model, the HSV (hue/saturation/brightness) color model, and opacity.

The currently selected color is shown in the Active Swatch box. This color is also 
indicated on the Color Spectrum and the Color Field by a color point (a white dot), 
and on the Color Detail control by a highlighted box.

Color Spectrum Color Detail Color Field

Color Detail Zoom

To make it easier to select and fine-tune specific colors, the Color Detail control 
displays colors adjacent to the currently selected color. Using the Color Detail 
Zoom slider, you can adjust the range of colors displayed in the Color Detail 
control. When you zoom in and out, the white bounding box on the Color 
Spectrum shrinks or expands to indicate the region displayed in the Color Detail 
control. The more you zoom in, the smaller the difference between adjacent colors 
in the Color Detail control.

RGB Sliders HSV Sliders

You can change the currently selected color by dragging the white dot to a new 
location on any of the color controls, or by using the RGB and HSV sliders, in any 
combination. If the Live Play check box is selected, any lights connected to your 
computer will display the Active Swatch color.

Zoomed in

Less difference  
between adjacent colors

Zoomed out

More difference  
between adjacent colors
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The White Range

The White Range targets an area within the CIE 1931 x-y chromaticity space, on 
which CCTs (correlated color temperatures) for white light are defined. To make 
it easier to select temperatures of white light and tinted white light, the White 
Range constrains color selections to an area along the black-body curve and the iso 
lines that extend above and below it. To select colors outside of this area, use the 
RGB Range.

The White Range lets you select a specific temperature or tint of white using the 
Chromaticity Diagram, as well as the Tint slider and the CCT slider. The currently 
selected white appears in the Active Swatch. The currently selected white is also 
indicated on the Chromaticity Diagram by a color point (a white dot), and by 
positions on the Tint and CCT sliders.

CCT Slider

Tint Slider
Chromaticity 
Diagram

You can change the currently selected white by dragging the white dot to a new 
location on the Chromaticity Diagram, or by using the Tint slider and CCT slider, in 
any combination. The CCT slider moves the color point along the black-body curve, 
while the Tint slider moves the color point perpendicular to the black-body curve, 
parallel with the iso lines. If the Live Play check box is selected, any lights connected 
to your computer will display the Active Swatch color.

Color 

The White Range constrains 
selections to an area along the 

black-body curve, as well as the 
iso lines above and below it.

For colors outside the White 
Range, use the RGB Range.

definitions created with the White Range differ depending on fixture type. To 
reuse temperatures of white and tinted whites with different fixture types, make 
sure you save them to your Project Swatches. You can then reload the colors and 
resave the effects when you change fixture types.

D The White Range helps you 
target temperatures and tints of 
white light using color-changing 
fixtures of three or more channels. 
You can also use the RGB Range 
with IntelliWhite fixtures in 
3-channel mode.

E The color point and the slider 
positions make a general indication 
of CCT and tint, and do not imply or 
guarantee color accuracy or color 
consistency across different fixture 
types. Think of the color point and 
slider positions as good starting 
points. If targeting an exact color 
temperature or x-y coordinate is 
critical, be sure to use a light meter 
or other measurement device to 
test the output of your lighting 
fixtures.
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Switch Between the RGB Range and the White 
Range
ColorPlay 3 offers two convenient methods for displaying the intended color range.

To switch between color ranges:

•	 Using the buttons: Click the Display RGB Range or the Display White Range 
button to toggle between the RGB Range and the White Range.

•	 Using Project Swatches: Select a swatch. The applicable color range is 
displayed. Swatches from the White Range are shown with a small triangle in 
the upper-right corner of the icon.

Use the Active Swatch and Comparison 
Swatches
The Active Swatch and Comparison Swatches make it easier to compare and 
select colors.

Active Swatch

Comparison Swatches

The currently selected color appears in the Active Swatch. When you save settings 
for the Fixed Color or Variable Color effect, or when you add a color to the Custom 
Wash effect, ColorPlay 3 uses the currently loaded color in the Active Swatch.

To load a color into the Active Swatch:

To load a color into the Active Swatch, select the intended color from the 
Project Swatches.

To load a color into the Comparison Swatches:

To load a color into a Comparison Swatch, drag the desired color from the Active 
Swatch, from the Color Detail control, or from your Project Swatches.

Use Advanced Channel Control
Chromasync Enabled check box Information

Advanced Channel slidersDisplay Advanced Channel Control

Target Fixture list

For most users, the standard RGB Range and White Range color selection options 
are enough to meet the expectations of a lighting designer. For users who want a 
little more control, ColorPlay 3 offers the Advanced Channel Control.

Display 
RGB Range

Display 
White Range

RGB Range swatches White Range swatches

C The values shown in 
Advanced Channel Control are 
a representation of the values 
calculated on the target fixture, and 
they may not match the actual DMX 
values that are stored in the light 
show.
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Which Fixture Profile Should I Use with Advanced 
Channel Control?
Advanced Channel Control displays the LED channel values that are transmitted 
to the Target Fixture. For the best and most reliable results, select a Target 
Fixture that matches a fixture in your lighting installation. If you are able to 
see your fixtures, choose a reference fixture, and select that fixture from the 
Target Fixture list. The values shown in Advanced Channel Control will reflect 
the Target Fixture, while other fixtures will match color according to their 
own configurations.

If you are using third-party fixture, select a generic fixture from the Target 
Fixture list. Available generic options are Generic RGB, Generic RGBA, Generic 
RGBW, and Generic RGBAW.

To use Advanced Channel Control:
1.	 Click the Display Advanced Channel Control button.
2.	 In your lighting installation, choose a fixture to use as a reference. Select 

that fixture from the Target Fixture list. If Chromasync is enabled on that 
fixture, select the Chromasync Enabled check box. The Advanced Channel 
sliders specific to the selected fixture are shown to the right.

3.	 Adjust the Advanced Channel sliders as needed.
Colors that have been modified from Advanced Channel Control are shown with 
a small indicator ( ) at different places in the Palette Editor. Some examples of 
these are shown in the margin.

Project Swatches and Project 
Palettes
ColorPlay 3 offers robust functionality for managing colors for your light shows. 
The Project Swatches list allows you to save and load single colors, while the 
Palettes list maintains a list of all multi-color palettes used in the current project.

Display Project 
Swatches List

Display Project 
Palettes List

If the currently selected effect can only use a single color, such as Fixed Color Effect, 
the Palettes list is unavailable.

Work with Project Swatches

Export Selected SwatchesImport Swatches

User Group

Create New 
User Group Filter

The Project Swatches list contains colors that are saved for later use in ColorPlay 3. 
Project Swatches are organized into User Groups.

Display Advanced 
Channel Control

Active Swatch

Project Swatches

Modified using 
Advanced Channel 

Control
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By default, ColorPlay 3 offers two User Groups that cannot be modified:

•	 PCK Swatches includes 12 RGB colors and 20 temperatures or tints of white.

•	 Apollo Gel Swatches includes colors matched to Apollo color catalog offerings.

To create, rename, or delete a swatch:

•	 To create a new swatch, select a color and click the Add to Project Swatches 
button. The new swatch appears with a default name (Color, Color 2, Color 3, 
and so on) in the Project Swatches User Group.

•	 To rename a swatch, double-click the swatch, and then enter a new name.

•	 To delete a swatch, right-click the swatch, and then click Delete.

To apply a swatch to the current effect:

To apply a swatch, do one of these actions:

•	 Click an RGB swatch to display the RGB Range and load the selected color into 
the Active Swatch.

•	 Click a White swatch to display the White Range and load the selected color 
into the Active Swatch. White Range colors are indicated by a white triangle in 
the upper-right corner of the swatch icon.

•	 Type in the Filter text box to limit the Project Swatches list to only those colors 
whose names contain the search string. Click  to clear the search string and 
display all available colors.

To create, rename, or delete a user group:

•	 To create a new user group, click the Create a New User Group button. The new 
user group is shown at the bottom of the Favorites list.

•	 To rename a user group, double-click the user group title, and enter a 
new name.

•	 To delete a user group, right-click the user group title, and then click Delete.

•	 Click the title of a user group to expand or collapse that group.

To import and export swatches:

•	 To export, select one or more swatch, and then click the Export Selected 
Swatches to a File button. Enter a file name and location, and then 
click Save. The CK Color File export is saved to your computer with the 
.ckcolors extension.

•	 To import, click the Import Swatches From a File to a New User Group button. 
Select a CK Color File (.ckcolors extension) from your computer, and then click 
Open. A new user group containing the imported swatches is created.

Work with Project Palettes

The Project Palettes list contains palettes that are used in the current ColorPlay 3 
project. Each palette is shown with the following information:

Add color to 
Project Swatches

E To select multiple Project 
Swatches for export, hold down the 
Ctrl key (Windows) or the Command 
key (Mac OS X), and then click the 
Project Swatches you intend to 
export.
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•	 A user-asigned name, shown in quotes. If a palette has not been named, 
no name is shown.

•	 The number of effects that use this palette in the current project. No 
number is shown next to unused palettes.

To create a palette:

To create a palette, simply add or remove colors to the Color Bar. A new entry is 
created in the Project Palettes list. By default, new palettes are not named.

To duplicate, rename, or delete a palette:

•	 To duplicate a palette, right-click the palette, and then select Duplicate.

•	 To rename a palette, right-click the palette, and then select Rename. Enter a 
name in the dialog box, and then click OK.

•	 To delete a single unused palette, right-click the palette, and then 
select Delete.

•	 To delete all unused palettes, right-click any palette, and then select Delete 
All Unused Palettes.

To apply a palette:

Click a palette to apply it to the current effect.

Palette Editor Keyboard Shortcuts
Color 

Range
To do this Press

RGB Range 

only

Zoom in on the Color Spectrum Ctrl+Plus Sign

Zoom out on the Color Spectrum Ctrl+Minus Sign

White 

Range 

only

Increase red Ctrl+R

Decrease red Ctrl+Shift+R

Increase green Ctrl+G

Decrease green Ctrl+Shift+G

Increase blue Ctrl+B

Decrease blue Ctrl+Shift+B

RGB Range 

and White 

Range

Select a color diagram without moving the 

color point

Hold down Ctrl, and then click in 

an inactive color diagram

Move the color point on a color diagram
Select a color diagram, and then 

press an arrow key

Move a slider to the left or right
Select a slider, and then press Left 

Arrow or Right Arrow

Move a slider up or down
Select a slider, and then press Up 

Arrow or Down Arrow

Copy Comparison Swatch 1 to the Active 

Swatch
Ctrl+1

Copy Comparison Swatch 2 to the Active 

Swatch
Ctrl+2

Copy Comparison Swatch to the Active 

Swatch
Ctrl+3
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6	 Timeline Editor

The Timeline Editor lets you sequence, transition, set the start time, end time, 
and duration of, and fine-tune effects. You can stack multiple effects on the same 
group of nodes, creating complex, multi-layered light shows.

Simulation playback controls let you preview shows on your computer or on your 
installed lights.

Timeline

Timeline Zoom Slider

Groups List

Show List Show Playback Controls Counter Live PlayMark In/Mark Out

The timeline is a visual representation of the sequence of effects in a show. Tick 
marks divide the timeline into regular intervals. You can use the Timeline Zoom 
Slider to bring a larger or smaller portion of a show into view.

The timeline lets you change many effect and show properties using simple drag-
and-drop actions. In the timeline, you can:

•	 Add, duplicate, and delete effects

•	 Set effect start time, end time, and duration

•	 Create and modify effect transitions

•	 Assign multiple timeline rows to a group for effect stacking

•	 Change the priority of stacked effects

•	 Create multiple shows for the same set of nodes and groups, and save them in 
a single file

•	 Switch between saved shows

•	 Debug, simulate, and play back shows
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Changing the Timeline Scale
The Timeline Scale Slider expands and contracts the visible portion of the timeline 
for easy access to show segments or entire shows. At maximum zoom, the 
timeline displays effects in increments of one second, with secondary tick marks at 
each half second.

Adding and Deleting Timeline Rows
A show consists of one or more timeline rows, each of which can contain 
multiple effects. Because you assign effects to groups, each group in a show is 
automatically assigned a timeline row when the group is created. When you assign 
effects to a group, the effects appear in the timeline row associated with the 
group. You can change the order of rows in the stack, add timeline rows to a group 
for effect stacking, and delete timeline rows.

To add rows to the timeline:

•	 Create a group. A timeline row for the group is automatically added to the 
timeline. The timeline row is identified by the group’s name. New timeline rows 
appear at the bottom of the stack.

•	 To assign another timeline row to a group, click the plus [+] icon in a group’s 
timeline row. New timeline rows are added immediately below the row 
you clicked.

	 Each timeline row is identified with the group’s name. (Changing the group 
name automatically changes the names of all timeline rows assigned to 
the group).

To delete rows from the timeline:

•	 To delete a row from the timeline, click the minus [–] icon in the row you want 
to delete.

	 Any effects assigned to the deleted row are also deleted. You can delete the 
last row for a group without deleting the group. When you assign an effect to 
the group, a timeline row is automatically created for that group.

•	 To delete all unused timeline rows (timeline rows that contain no effects), click 
the Show Chooser and select Hide All Unused Timeline Rows.

Working with Effects in the Timeline
You can perform many actions on effects in the timeline using the mouse. You can 
add effects to and remove effects from the timeline; change the start time, end 
time, and duration of effects; and copy, cut, paste, and move effects within and 
between timeline rows.

E Each second of an effect 
contains 40 frames (1 frame = 
.25 seconds).

E The set of timeline rows is 
called the stack.

Group name Add row for group

Delete row
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To add effects to the timeline:

•	 When you assign an effect to a group, the effect automatically appears in the 
timeline row associated with that group, at the default duration of 5 seconds.

	 If the group has multiple timeline rows, the effect appears in the topmost row 
for that group.

	

If a group has multiple timeline rows... ...effects are added to the topmost row 
for that group

If the timeline row already contains effects, the new effect is inserted at the 
first gap in the timeline.

	

...new effects are inserted after the first 
gap in the timeline

If the timeline row already contains 
effects...

You can drageffects directly onto the timeline. Effects are added with the 
default duration of 5 seconds. You can only drop effects where there is at least 
a 5-second gap in the timeline.

To select effects in the timeline:

•	 Click an effect to select it.

•	 Hold Shift or Ctrl while clicking to select multiple effects.

•	 Drag the mouse across the timeline to select all effects under the 
bounding box.

•	 With the Effects layer selected, press Ctrl+A to select all effects in the timeline.

To copy, cut, and paste effects in the timeline:

1.	 Select one or more effects.

2.	 Copy the selected effects by choosing Edit>Copy or pressing Ctrl+C, or cut 
them by choosing Edit>Cut or pressing Ctrl+X.

3.	 Paste the cut or copied effects by choosing Edit>Paste or pressing Ctrl+V.

If you copy and paste a single effect, the effect is added to the timeline row from 
which you copied it, immediately following the last effect in the row.

If you copy and paste multiple effects, each pasted effect is added to the same 
row from which you copied it, at the earliest point in the timeline that can 
accommodate all copied effects. Gaps between effects are preserved.

To remove effects from the timeline:

1.	 Select one or more effects.

2.	 Do one of the following:

•	 Cut the effects by choosing Edit>Cut or pressing Ctrl+X.

•	 Delete the effects by choosing Edit>Delete or pressing Delete.
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Changing Effect Start Time, End Time, and 
Duration
Each effect has a start time, end time, and duration in the timeline. The left edge of 
an effect block represents the start time, while the right edge represents the end 
time. Together, the start time and end time establish the effect duration.

To change the start time, end time, and duration of an effect in the timeline:

•	 Dragging an effect to a new location in the timeline changes the start time and 
end time but does not change the duration. 
 
You cannot drag an effect into an area already occupied by another effect 
(effects cannot overlap in the same timeline row). You can overlap effects by 
stacking them in separate timeline rows (see “Creating Multi-Layered Effects” 
below).

•	 Dragging the left edge of an effect changes the start time and duration of the 
effect, but does not change the end time.

•	 Dragging the right edge of an effect changes the end time and duration of the 
effect, but does not change the start time.

•	 Double-click an effect to autofill empty timeline space before the effect’s 
start time.

Double-click an effect to fill in a timeline gap to its left

Creating Multi-Layered Effects
You can create multi-layered effects by assigning multiple groups to the same set 
of lights, or multiple timeline rows to same group, then adding effects to more 
than one row with the same or overlapping durations. Effects on top have priority 
over the effects below them. If there are gaps in an effect, or if the effect has 
transparency, effects stacked below it “show through.” When defining colors for 
an effect, you can create transparency by setting opacity to less than 100%. Many 
effects let you make the foreground colors transparent so that any effects beneath 
them in a stack show through the ripple of particle patterns.

A lower-priority effect becomes visible when:

•	 There are gaps between effects in a higher-priority timeline rows

•	 A higher-priority effect ends but the lower-priority effect continues

•	 A higher-priority effect has transparency, in which case the lower-priority effect 
“shows through” the transparent areas of the higher-priority effect

•	 A higher priority effect simulation is made invisible by clicking the eye icon

To stack effects:

1.	 Assign two or more timeline rows to a group.

2.	 Add effects to two or more timeline rows for the same group.

3.	 Adjust effect start time, end time, or duration as necessary to overlap effects 
in multiple rows.
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4.	 Adjust effect blocks in higher-priority row to create gaps through which lower-
priority effects can become visible, or use transparency in an effect with a 
higher priority so that lower-priority effects can show through.

Changing the Priority of Timeline Rows and 
Effects
When multiple timeline rows are assigned to the same group, the rows on top 
have priority over the rows below them. Likewise, effects in rows on top have 
priority over effects in rows below them.

•	 To change the priority of an individual effect, select the effect, and drag it to a 
higher row (giving it higher priority) or a lower row (giving it lower priority).

•	 To change the priority of a timeline row, select the row in the Groups List and 
drag it to a new position within the set of rows assigned to a group.
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Working with Shows
A ColorPlay 3 project can contain multiple shows. The Show Chooser lets you add, 
select, rename, and delete shows.

To create a show:

1.	 Click the Show Chooser and select Add.

2.	 Enter a name for the show, and click OK. Each time you add a show, a new 
entry appears in the Show Chooser menu.

Effects in lower rows “show through” gaps or transparency in effects in the rows above them

To select a show:

Click the Show Chooser and select the show’s name. The mapping area and 
timeline display the selected show.

To rename a show:

1.	 Select the show from the Show Chooser.

2.	 Click the Show Chooser again, and select Rename.

3.	 Enter a new name for the show, and click OK.

To delete a show:

1.	 Select the show from the Show Chooser.

2.	 Click the Show Chooser again and select Delete.

Simulating Shows
The timeline’s Simulation, Mark In/Mark Out, and Live Play controls let you 
simulate and test your shows in real-time. As you assign new effects and edit 
effect properties, you can preview the changes immediately by playing your show 
either on-screen or live on your fixture layout.

To preview a show on-screen using the Simulate controls:

1.	 Click the Play button to begin the simulation.

2.	 Click the Fast Forward, Fast Rewind, Jump to Start, and Pause buttons to 
control on-screen show playback.

3.	 Turn the visibility of a timeline row on or off by clicking the eye icon associated 
with the row.

Scrubbing Video with the Timeline
You can scrub video in fine detail by dragging the virtual playhead back and forth 
across the timeline. When you release the playhead, it remains in that position. 
Zoom all way in on the timeline for frame-by-frame access.

E If your project contains only 
one show, you cannot delete 
the show.

Row visibility on

Row visibility off
Playhead
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You can navigate directly to any frame within the timeline by entering a value in 
the counter and pressing Enter. You can enter seconds, minutes, hours, days, or 
frames. For example, if you enter 100f and press Enter, the playhead moves to 
frame 100 in the timeline. The counter displays the location of the frame in the 
timeline in DD:HH:MM:SS format.

Using the Mark In/Mark Out Controls
You can set mark in and mark out points on the timeline to restrict video playback 
to a segment of the timeline. Setting a mark in point and no mark out point plays 
the timeline from that point to the end of the timeline. Setting a mark out point 
and no mark in point plays the timeline from the beginning to the mark out point. 
Setting both mark in and mark out points plays the segment of the timeline 
between the points only.

To set mark in and mark out points:

1.	 If you’re setting a mark in point, drag the playhead to the frame on which you 
want to set the mark in point and click the Set Mark In Point button, or enter a 
time value in the mark in counter and press Enter.

2.	 If you’re setting a mark out point, drag the playhead to the frame on which 
you want to set the mark out point and click the Set Mark Out Point button, or 
enter a time value in the mark out counter and press Enter.

3.	 Click the Loop While Simulating button to determine how to play back the 
segment of the timeline between the marks while simulating. You can set 
playback to play once only, or to loop.

To clear mark in and mark out points:

Click the Clear Marks button to clear both the mark in and mark out points from 
the timeline.

Clear Marks

Loop While Simulating

Set Mark In Point

Set Mark Out Point

Mark In Point Mark Out Point

Play between marks once

Loop between marks
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Simulating a Show with Live Play
To simulate a show with Live Play, ensure that an iPlayer 3 controller is connected 
to your lighting network and operating properly. You must also have properly 
connected and configured lighting fixtures.

To simulate a show on connected lights:

1.	 Click the Live Play button to initiate live playback mode.

2.	 Click the Fast Forward, Fast Rewind, Jump to Start, and Pause buttons to 
control show simulation.

3.	 Turn the visibility of a timeline row on or off by clicking the eye icon associated 
with the row.

4.	 Click the Live Play button again to exit live playback mode.

Working with Lighting Visualization Software
Lighting visualization software lets you create a 3D model of an installation, with 
accurate lighting output data, for design refinement and simulation purposes. By 
default, during Live Play simulation, ColorPlay 3 broadcasts DMX data over the 
Ethernet lighting network to any listening visualizer clients.

ColorPlay 3 supports the following third-party visualization software:

•	 WYSIWYG

•	 Capture Polar

•	 ESPVision

Refer to your visualizer software guide for installation and 
configuration instructions.

To simulate a show with an external visualizer client:

1.	 Create a show.

2.	 Launch a visualizer client on the local lighting network.

3.	 In the visualizer client, connect to the ColorPlay 3 running instance (refer to 
your visualizer software guide for details).

4.	 Press the Live Play button in ColorPlay 3 to initiate live playback mode. 
The show data displayed in ColorPlay 3 matches the data displayed in 
the visualizer.

5.	 Click the Fast Forward, Fast Rewind, Jump to Start, and Pause buttons to 
control playback. as you would with an on-screen simulation.

To turn off visualization data broadcast:

1.	 Select Edit>Preferences.

2.	 Click the General tab.

3.	 Clear the Send DMX data to visualizer application check box.

Live Play
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7	 Configuring Shows

Once you’ve authored and saved one or more shows, you can download them 
to an iPlayer 3 controller or to the SD card installed in a ColorBlaze TRX lighting 
fixture. You complete show configuration by configuring and downloading triggers. 
You can also configure and download optional alarms for iPlayer 3

You can interface directly with iPlayer 3, iColor Player, or ColorBlaze TRX from the 
Configuration layer within ColorPlay 3. To display the Configuration layer, click the 
Configuration tab or select Layer>Configuration.

Connecting a Device
Once you’ve connected a computer running ColorPlay 3 to an iPlayer 3 controller 
or ColorBlaze TRX lighting fixture, you can view controller information and work 
with shows and triggers. You can also set alarms for iPlayer 3.

To connect to a device:

1.	 Do one of the following:

•	 Using a USB cable, connect a computer running ColorPlay 3 to an iPlayer 3 
or iColor Player controller.
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•	 Using a standard CAT-5e or better cable, connect a computer running 
ColorPlay 3 to an Ethernet switch to which one or more ColorBlaze TRX 
fixtures are attached, or connect the cable directly to the Ethernet In port 
on a ColorBlaze TRX fixture.

2.	 From the list at the top of the Configuration layer, select the controller or 
ColorBlaze TRX fixture to which you want to connect. ColorBlaze TRX fixtures 
are identified by IP address.

3.	 Click Connect. If the connection is successful, the Configuration layer shows a 
message that reads “Connected.”

4.	 To disconnect from the connected device, click Disconnect.

Working with Show Files
When you display the Configuration layer, the Show Files tab appears by default. 
You use the Show Files tab to copy show files to and from the connected device, 
render shows, save shows, and delete files from the connected device.

Copying Show Files to a Connected Device
To play shows from a device such as iPlayer 3 or ColorBlaze TRX, you must copy 
them from your computer to the device itself. Once copied, show files appear in 
the Files on Controller list with a .SHO file extension.

By default, ColorPlay 3 includes project data when copying .SHO files to iPlayer 
3. Including project data adds to file size, but it allows a .SHO file to act as an 
archive from which you can extract the project that includes the show file to any 
connected computer.

To copy show files to a connected device:

1.	 If desired, turn project data on or off by selecting Edit>Preferences. On the 
General tab, select or clear the Include project data when copying shows to 
controller check box, and then click OK.

2.	 Select one or more show files in the Show Files in Project list.

3.	 Click the Copy Selected Controls to Controller arrow button.

Shows that contain project data are identified in the Files on Controller list with an 
orange icon.
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Rendering Shows Manually
When you copy show files to a connected device, ColorPlay 3 automatically 
renders those files (converts them to a format usable by the device). You can also 
manually render show files before copying them. You might want to render shows 
manually if you’re finishing a project and aren’t currently connected to a device, or 
to save time copying files (shows with complex video effects can be large, and can 
therefore take some time to render).

To render shows manually:

1.	 Select one or more show files in the Show Files in Project list.

2.	 Right-click, and select Render Selected Shows from the pop-up menu.

Saving and Adding Show Files
You can save one or more show files to a file on your computer (.SHO extension). 
You can copy (add) saved .SHO files to a connected device.

When saving show files from the open project to your computer, you can choose 
to also write DMX data. ColorPlay 3 creates two additional files: <filename>_
port1.dmx and <filename>_port2.dmx. These files are compatible with certain 
controllers, including iPlayer 2 from Color Kinetics.

To save show files to a file:

1.	 Select one or more show files in the Show Files in Project or Files on 
Controller list.

2.	 Right-click, then select Save from the pop-up menu.

3.	 Do one of the following:

•	 If saving show files in the project, browse to a destination folder. To also 
write DMX data, select the Also write DMX DATA check box. Click Save.

•	 If saving show files on the controller, browse to a destination folder and 
click OK.

To copy show files to a connected device:

1.	 Right-click the Files on Controller list, then select Add File from the pop-
up menu.

2.	 Navigate to and select the .SHO file you want to load, and then click Open.

To delete a show file from a connected device:

1.	 Select one or more show files in the Files on Controller list.

2.	 Right-click, and select Delete from the pop-up menu.

3.	 Click Yes.

To extract a show file with project data

1.	 Select one or more show files with project data in the Files on Controller list.

2.	 Right-click, and select Extract Project from the pop-up menu.

3.	 Select a destination folder on your computer, then click OK.
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Working with Triggers

To play a show file with iPlayer 3, you must configure a trigger, assign it to a preset 
show or show file, and copy it to iPlayer 3. You can play triggers or shows from the 
ColorBlaze TRX on-board menus, but you must use triggers to play shows with 
DMX triggers or Ethernet Controller Keypaad

ColorPlay 3 offers 256 trigger numbers. You can access all 256 triggers via the 
iPlayer 3 menu system or the ColorBlaze TRX on-board menus. Additionally, 
trigger numbers 1 – 5 correspond to the show preset buttons on the faceplate of 
the iPlayer 3, and triggers 1 – 10 correspond to regions 1 – 10 of the DMX trigger. 
When using Controller Keypad with iPlayer 3, you can play shows assigned to any 
eight consecutively numbered triggers. When using Ethernet Controller Keypad 
with ColorBlaze TRX, you can play triggers 1 – 8.

Configuring Triggers
When you configure a trigger, you assign a transition and a preset or rendered 
show to play. Additional options are available, depending on show type.

To configure triggers:

1.	 On the Configuration layer, click the Triggers tab. If you’re connected to a 
device, triggers in ColorPlay 3 which don’t match those on the connected 
device appear in bold red.

2.	 To configure a trigger, double-click a trigger in the Triggers in Project list.

3.	 Select a trigger number (1 – 256) from the Trigger list.

4.	 Select a transition from the Transition list. Transitions determine how the show 
associated with the trigger begins:

•	 Snap jumps abruptly from previous light output to the assigned show

•	 Fade Out & In fades out previous light output, then fades in the assigned 
show

•	 Cross Fade fades out previous light output and fades in the assigned 
show simultaneously

	 For Fade Out & In and Cross Fade, enter a transition time in the Time control.

5.	 To assign the trigger to a preset show (iPlayer 3 only):

•	 Select a preset show from the Play list.

•	 Enter show properties. Properties differ depending on the effect assigned 
to the preset show type. See Chapter 5 for complete details on effects and 
their properties.

•	 Click OK.

E You can reorder triggers in the Triggers 
in Project list by dragging them.
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6.	 To assign the trigger to a show you created:

•	 Select Rendered Show from the Play list.

•	 Select a show file in your ColorPlay 3 project from the list that appears 
below the Play list.

•	 Select a behavior from the then list to determine how the show ends:

	 Repeat repeats the selected show

	 Fade to Black plays the show once, then fades light output to black

	 Jump to Trigger transitions to a show assigned to another trigger. Select a 
trigger number from the list. The transition between shows is determined 
by the Transition selection in the trigger assigned to the show you’re 
jumping to.

•	 Click OK.

7.	 To set an empty trigger:

•	 Select Nothing from the Play list.

•	 Click OK.

Copying Triggers to and from a Connected 
Device
Once you’ve configured the triggers you need, you must copy them to the 
connected device to play the shows assigned to them. You can copy all triggers, 
or selected triggers. You can also copy triggers from the connected device to the 
open project.

To copy selected triggers to a device:

1.	 Select one or more triggers in the Triggers in Project list.

2.	 Click the Copy Selected Triggers to Controller arrow button.

To copy all triggers to a device

Click the Copy All Triggers to Controller arrow button.

To copy selected triggers to the open project:

1.	 Select one or more triggers in the Triggers on Controller list.

2.	 Click the Copy Selected Triggers to Project arrow button.

To copy all triggers to the open project:

Click the Copy All Triggers to Project arrow button.
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Saving Triggers to and Loading Triggers from 
Files
For convenience, you can save selected triggers to a file (.IP3 extension), and load 
the file into ColorPlay 3 on any computer.

To save triggers to a file:

1.	 Select one or more triggers in Triggers in Project list.

2.	 Right-click, then select Save Triggers to File from the pop-up menu.

3.	 Give the .IP3 file a name, select a location to save the file, and click Save.

To load triggers from a file:

1.	 Right-click the Triggers in Project list, then select Load Triggers from File from 
the pop-up menu.

2.	 Navigate to and select the .IP3 file you want to load, and then click Open.

Deleting Triggers
You can delete triggers in the open project. If you’re connected to a device, you can 
also delete triggers on the device. When you delete a trigger, the trigger is reset 
to the default (play Nothing with a Snap transition), but the trigger number is not 
removed from ColorPlay 3 or the connected device.

To delete a trigger:

Right-click a trigger in the Triggers in Project or Triggers on Controller list, and then 
select Delete Trigger from the pop-up menu.

Working with Alarms for iPlayer 3
You can use alarms to automatically activate triggers on iPlayer 3. For example, 
you can set an alarm to activate a trigger every Monday at 5:00:00 p.m., or when 
an astronomical event occurs (sunrise or sunset on weekdays, for instance).

Configuring Alarms
When you configure an alarm, you specify when the alarm will go off, and you 
associate a trigger to activate. Activating a trigger with an alarm plays the show 
assigned to the trigger.

To configure alarms:

1.	 On the Configuration layer, click the Alarms tab. If you’re connected to iPlayer 
3, alarms in ColorPlay 3 which don’t match those on iPlayer 3 appear in 
bold red.
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2.	 To configure an alarm, double-click an alarm in the Alarms in Project list.

3.	 Select an alarm number (1 – 64) from the Alarm list.

4.	 Select an alarm type from the Type list. Alarms can be set to go off on a 
specific month and day, every day, every weekend day, every weekday, or 
every Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, or Sunday.

5.	 Select a time for the alarm:

•	 To set the alarm to go off at a specific time of day, click Time of Day and 
enter a time (HH:MM:SS).

•	 To set the alarm to go off relative to sunrise or sunset, click Astronomical. 
Select Before Sunrise, After Sunrise, Before Sunset, or After Sunset, then 
select how long before or after the selected astronomical event (H:MM).

6.	 Select a trigger to activate in the Play Trigger control, and then click OK.

Copying Alarms to and from iPlayer 3
Once you’ve configured the alarms you need, you must copy them to iPlayer 3 to activate 
the triggers assigned to them. You can copy all alarms, or selected alarms. You can 
also copy alarms from the controller to the open project.

To copy selected alarms to iPlayer 3:

1.	 Select one or more alarms in the Alarms in Project list.

2.	 Click the Copy Selected Alarms to Controller arrow button.

To copy all alarms to iPlayer 3:

Click the Copy All Alarms to Controller arrow button.

To copy selected alarms to the open project:

1.	 Select one or more alarms in the Alarms on Controller list.

2.	 Click the Copy Selected Alarms to Project arrow button.

To copying all alarms to the open project

Click the Copy All Alarms to Project arrow button.

Deleting Alarms
You can delete alarms in the open project. If you’re connected to an iPlayer 3, you 
can also delete alarms on the controller. When you delete an alarm, the alarm is 
reset to the default (Off), but the alarm number is not removed from ColorPlay 3 
or iPlayer 3.

To delete alarms:

1.	 Right-click an alarm in the Alarms in Project or Alarms on Controller list.

2.	 Select Delete Alarm from the pop-up menu.

E You can reorder alarms in the Alarms in 
Project list by dragging them.
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Managing iPlayer 3 Settings
When connected to an iPlayer 3 controller, you can read and set iPlayer 3 date, 
time, and location, which are used by astronomical alarms.

To reading iPlayer 3 settings

Connect to an iPlayer 3 controller, and click Read Settings from iPlayer 3. The Date 
& Time and Location fields update to display the current iPlayer 3 settings.

To set iPlayer 3 date, time, and location

1.	 Connect to an iPlayer 3 controller.

2.	 Use the date/time control to set the current date and time, or select the Use 
computer’s date and time check box to read date and time settings from your 
computer. If daylight savings time is currently in effect, select the Daylight 
Savings Time check box.

3.	 Use the Latitude, Longitude, and Time Zone controls to specify a location, or 
use the Country and City lists to select a location. Selecting a country and city 
automatically updates latitude, longitude, and time zone.

4.	 Click Write Settings to iPlayer 3.
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A	 ColorPlay 3 

Preferences
You can set ColorPlay 3 preferences for mapping, timeline, debugging, and 
updates. To change ColorPlay 3 preferences, click Edit>Preferences.

General
Include project 
data when shows 
to controller

Packages all of the shows in a ColorPlay 3 project into 
a .PR0J file. .PROJ files can be copied to an iPlayer 3, 
then extracted later

Send DMX data 
to visualizer 
application

Broadcasts DMX data on the lighting network so 
that supported third-party lighting visualization 
applications can capture the data

Mapping

Always show 
Fixture addresses

Check to display fixture addresses on the Fixtures 
Layer.Uncheck to hide fixture addresses on the 
Fixtures Layer

Always show 
Fixture profiles

Check to display fixture profiles on the Fixtures Layer 
by default 
Uncheck to hide fixture profiles on the Fixtures Layer 
by default

Snap to Grid
Turns snap to grid off and on for Fixtures and Groups 
layers

Grid Size
Default grid spacing for Fixtures, Groups, and 
Background layers

Default Map Size Default size of mapping area, in pixels

Timeline
Loop while 
simulating

Turns show looping off and on in Timeline when 
simulating

Background Color Sets the background color of the Timeline

Debugging
Show Debug 
Properties

Turns debug messaging on and off

Updates

Automatically check 
for updates

Turns automatic update notification on and off. 
Enter an interval to check for updates, in days. Click 
Check Now to check the Internet for updates now. 
If you connect to the Internet with a proxy, check 
“Use a proxy to access the internet” and enter the 
proxy information.
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